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Chapter 1: Introduction 

Overall Learning Objectives 

These are the overall learning objectives for the eMaRC Plus Physician Reporting Module 

User’s Guide: 

• Learn the major functions of the eMaRC Plus Physician Reporting Module 

• Become familiar with the various available menu and toolbar items and the functions 

they execute 

• Understand how physician reports generated by Electronic Health Record (EHR) vendor 

software and submitted to central cancer registries by providers in the Clinical Document 

Architecture (CDA) are automatically processed through the application to generate 

abstracts in the NAACCR record layout for data exchange including: 

− Storing of CDA document data into associated section tables 

− Defaulting of values for NAACCR data items for which the CDA documents does 

not contain information 

− Mapping of values from the CDA document to the associated NAACCR data item 

− Translating values in the CDA document to the standard NAACCR data item 

codes and format 

− The Multiple Record Management Process by which information included in 

multiple CDA documents received by the central cancer registry from the same 

reporting entity for the same patient and tumor will be automatically processed 

and consolidated in eMaRC Plus  

− When and what types of messages are written to the Processing Log 

• Importing CDA documents 

• Searching for and concurrently viewing CDA documents and NAACCR abstracts side-

by-side on the CDA Workbench  

• Learning about the CDA Workbench and how to use it 

• Exporting abstracts in NAACCR file format 

• Become familiar with the Administrative features of the program, including: 

− Managing user accounts  

− Managing the Abstract Display 

− Managing the CDA document Display 

− Managing Facilities 

− Setting system configuration preferences 

− Deleting CDA documents 

• Running the application from the DOS Command line 

• Understanding the different ways the Physician Reporting Module can be used by central 

cancer registries 
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• Viewing Reports  

Overview of the eMaRC Plus Physician Reporting Module User’s 
Guide 

The eMaRC Plus Physician Reporting Module User’s Guide provides you with the information 

necessary to fully understand and use the application. Through this manual, users will be 

introduced to eMaRC Plus Physician Reporting Module menu items, user interfaces, and 

software functions and capabilities in a detailed, step-by-step manner. The intent of this user’s 

guide is to relate all information about the application to the user, including the granular details 

of data processing, in a completely transparent fashion and provide an avenue for feedback to 

CDC regarding all aspects of the application.  

Background 

The eMaRC (Electronic Mapping, Reporting and Coding) Plus software was initially developed 

for the NPCR- Advancing E-cancer Reporting and Registry Operations' ePath Project by the 

Registry Plus Development Team of the U.S. Centers for Disease Control and Prevention (CDC) 

in 2006. The eMaRC Plus ePath (electronic Pathology) Reporting Module reads Health Level 7 

International (HL7) version 2.3.1 and 2.5.1 Observation Result (ORU 01) message batch files, 

parses messages, and stores HL7 data elements as discrete field values into tables in the Pathlab 

database. In a typical setting, the Public Health Information Network Messaging System 

(PHINMS) is used to securely send HL7 batch files from a laboratory to a cancer registry or 

some other agency working on the cancer registry’s behalf. The eMaRC Plus resides at a cancer 

workstation and polls the worker queue of the PHINMS receiver for any new incoming files. 

When a new file arrives in the queue, the application selects it based on the text containing 

cancer terms, processes it, and then goes back in the waiting mode until another new file arrives. 

eMaRC Plus ePath Reporting Module can be used in an interactive mode where the user 

manually selects a file to import into the Pathlab database. 

During import, the ePath Module uses a terms table to search reports for potential cancer reports. 

Additionally, a built-in negation terms finder algorithm (NegEx) enhances the program’s text 

interpretation capabilities by discriminating the cancer term when used in a negative manner. 

The program displays imported pathology reports in a user-readable format with cancer terms 

highlighted in red and negated terms highlighted in blue.  

The ePath Module also creates partial abstracts from HL7 messages during import, translating 

coded values from the HL7 coding standard to the North American Association of Central 

Cancer Registries (NAACCR) standards. It allows you to view pathology report data items from 

the HL7 message side-by-side with abstract data items on the same screen. This allows the user 

to abstract NAACCR additional data items through review of the pathology report text.  

Beginning in 2012, the CDC’s Cancer Surveillance Branch staff developed a prototype of a new, 

separate, Physician Reporting Module that was included in the eMaRC Plus application in 

addition to the ePath module. The Physician Reporting Module receives and processes HL7 

Clinical Document Architecture (CDA) documents from physician office electronic health record 

(EHR) or electronic medical record (EMR) systems as part of Meaningful Use (MU) Stages 2 

and 3. 

http://www.cdc.gov/cancer/npcr/informatics/aerro/workgroups/epath.htm
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The CDA is a markup standard developed by the organization Health Level 7 International to 

define the structure of clinical documents such as discharge summaries and progress notes. CDA 

is based on XML, the Extensible Markup Language. The CDA uses HL7’s Reference 

Information Model, the goal of which is to put data in a clinical or administrative context, to 

define how pieces of data are associated, and to take advantage of coding systems such as 

Systematized Nomenclature of Medicine -- Clinical Terms (SNOMED CT) and Logical 

Observation Identifiers Names and Codes (LOINC). CDA enables the creation of patient records 

that can be read by any EHR/EMR software system. CDA is a flexible standard and is unique in 

that it can be read by the human eye or processed automatically by computer.  

Functionality has now been added to eMaRC Plus to enable the processing of physician reports 

generated by the EHR and received by the cancer registry in CDA document format, and 

mapping from the CDA data elements and codes to the NAACCR record layout and codes. A 

beta version of the eMaRC Plus Physician Reporting Module was released on September 30, 

2013. This document is intended for use with the production version of the Physician Reporting 

Module, first released in October of 2015.  

eMaRC Plus Physician Reporting Module Features 

The Physician Reporting module of eMaRC Plus was developed collaboratively by participants 

in the National Association of Central Cancer Registries (NAACCR) Physician Reporting 

Workgroup and programmed by the Registry Plus Development Team. 

The program includes functions to import HL7 CDA documents (manually, from a specific 

folder; through the DOS Command Line Interface; or via PHINMS), parse out codes and text 

from specific sections of the HL7 CDA document, and map or translate HL7 CDA data elements 

to NAACCR data items and coding conventions to automatically generate a NAACCR abstract. 

Default values can also be set for standard, required NAACCR data items for which no 

information is found in the CDA document.  

The Physician Reporting module of eMaRC Plus builds onto the already existing ePath database, 

so that a single database will have tables for both ePath and the Physician module. When 

updating to this new production version, CDC will distribute SQL scripts to add physician 

module tables to the existing pathlab database for SQL server users. Various HL7 data elements 

will be stored as discrete field values into tables in the database. The program creates NAACCR 

formatted abstract records from physician reports during import into the database. If multiple 

CDA documents are received by the central cancer registry from the same reporting entity for the 

same patient and tumor, the application will automatically consolidate all abstract values for each 

data item to generate a single, consolidated abstract.  

The eMaRC Plus Physician Reporting Module allows the user to concurrently examine a user-

friendly view of each CDA document and its associated automatically generated abstract side-

by-side so that the user can review the automated mapping decisions and provide feedback to the 

CDC. The program also offers a report which displays a user-specified view of NAACCR data 

items across all abstracts generated from multiple CDA documents received by the central cancer 

registry from the same reporting entity for the same patient and tumor along with the 

consolidated value automatically selected by the application, allowing the user to review the 

automated consolidation decisions and provide feedback to CDC.  
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System Requirements  

eMaRC Plus programs work with 64-bit Microsoft® Windows® operating systems on x86-

compatible processors. The minimum hardware requirements are the same as those of the 

Microsoft Windows operating system used. 
 

System requirements include: 

 

• Minimum Processor 1 GHz, but recommended Intel i5 with 1.9 GHz or better processor  

• Microsoft operating system Window 7, 8, and 10 or newer version.  

• Minimum of 2 GB but recommended 4 GB memory for smooth user experience. 

• Latest version of Microsoft Internet Explorer (recommended). 

• A minimum of 200 MB free hard drive space is required, which excludes eMaRC Plus 

database. 

• Microsoft .NET Framework Version 4.52 Full Version or newer version 

• Application comes with a default Microsoft Local DB Database for configuration and 

low budget use. For enterprise/production use, database must be reconfigured to work 

with SQL Server 2012 R2 or newer version.  

 

It is highly recommended to use a professional grade database server to avoid data loss (e.g., 

Database hosted on separate server gives you a more reliable platform. It is strongly 

recommended to do a back-up periodically, etc.). 

Downloading and Installing eMaRC Plus Version 9.0.0.X 

If you previously used eMaRC, you will receive a link via email with instructions to download 

and install eMaRC Plus Version 9.0.0.0. First time users, please contact the Helpdesk at 

cancerinformatics@cdc.gov for download and to be added to the distribution list.  

User Support 

For technical support via e-mail, contact cancerinformatics@cdc.gov. The CDC Registry Plus 

Development group is funded primarily to support NPCR-funded state central cancer registries.  

As a result, CDC helps state central cancer registries set up the software and perform basic 

customizations. CDC also provides periodic software updates and problem-solving to the extent 

of available resources.  

CDC does not provide on-site services, and does not support hospitals, clinics, laboratories, or 

other private users. eMaRC Plus is intended for distribution to central cancer registries after as-

needed customization by the central registry. The state central cancer registry using eMaRC Plus 

is responsible for providing all support to end users submitting data to the system. State registry 

contact information can be found at the National Program of Cancer Registries Web site:  

Contact a Local Registry.  

Other users of eMaRC Plus will need to independently understand and maintain the software 

application. 

mailto:cancerinformatics@cdc.gov
mailto:cancerinfo@cdc.gov?subject=eMaRC%20Plus%20Technical%20Support
https://nccd.cdc.gov/dcpc_Programs/index.aspx#/3
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Chapter 2: The Basics  

Learning Objectives 

In this chapter, you will learn to: 

• Launch eMaRC Plus 

• Log in and out of the eMaRC Plus Physician Reporting module 

• Familiarize yourself with the Physician Reporting module main window and identify the 

various menu items and toolbar icons 

• Generate your own user account 

• Change your password 

• Delete a user account 

• View important application contact and versioning information 

Overview 

This chapter covers the basics of the eMaRC Plus Physician Reporting module. You’ll learn 

about all of the ongoing, automated data processing that occurs in the modules, how to log in and 

out of the eMaRC Plus Physician Reporting module, and helpful information about generating 

and maintaining your user account.  

Launching eMaRC Plus 

Once installed, you can launch eMaRC Plus: 

1. From the Start menu, select All Programs → Registry Plus → eMaRC Plus → eMaRC 

Plus. 

2. The Administrator now has an option to sign into the System Configuration from the initial 

login dialog box. 

Logging Into the eMaRC Plus Physician Reporting Module 

After installing eMaRC Plus, upon initial launch of the program, you will be prompted to enter 

the default User ID of doe, the default password of guest, and select the eMaRC Plus module 

with which you would like to work (i.e., Physician Reporting rather than ePath Reporting). Once 

you have logged into the application, you will generate a new user account for yourself.  

 

Once all users at your central registry have their own user accounts, for 

security purposes, the doe user account should be deleted. 

 

When logged in with your own user ID and password, your User ID will be recorded in the 

Abstracted By NAACCR data item for all abstracts generated from any CDA documents that you 

import.  
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To log in to the Physician Reporting module of eMaRC Plus, complete these steps: 

1. Launch eMaRC Plus. 

Result: The eMaRC Plus Login window opens. 

  

2. Enter the default User ID of doe into the User ID field and press the Tab key or use your 

mouse to click into the Password field.  

Result: The cursor will move to the Password field. 

 

3. Enter the default Password of guest into the Password field. 

 

If you already have a User ID and password for eMaRC Plus, you would enter 

your own User ID and password rather than the above-specific default values. If 

you have an existing ePath Reporting User ID and password, these can be used to 

login to the Physician Reporting Module as well. 

4. Using the Select Module pull-down menu, select Physician Reporting. 
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5. Click OK. 

 

Result: The main eMaRC Plus Physician Reporting window opens. 
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The eMaRC Plus Physician Reporting Main Window 

The eMaRC Plus Physician Reporting main window provides access to all of the application’s 

features.  Important system messages are displayed in the lower left-hand corner of the window.  

When logged in, you will automatically have access to the majority of the application’s features 

via the main menu items. In addition, some functions are available via icons on the toolbar in the 

main window as described below.   

The File Menu 

The File menu is used to access the majority of features that are used to work with CDA 

documents and auto-generated abstracts.  To access the File menu items, click on the File menu 

item, and select the desired sub-option, or use the appropriate keystroke combination for the 

desired sub-option when available.  

 

The following table describes the eMaRC Plus Physician Reporting module File menu sub-

options: 

Sub-option (Keystroke) Toolbar Icon Function 

Import Physician Reports 

(Ctrl+N)  
Manually import CDA 

documents 

Poll and Import Physician 

Reports from PHINMS 

Queue 

 

Check for and import CDA 

documents from the 

PHINMS queue  

Poll and Import Physician 

Reports from Folder 
 

Check for and import CDA 

documents from a user-

specified folder 

Open Physician Reports 

(Ctrl+O)  

Open and view an 

individual CDA document 

in the CDA workbench 

Export Abstracts  

Export abstracts out of the 

eMaRC Plus database in 

NAACCR-formatted files  
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Sub-option (Keystroke) Toolbar Icon Function 

Exit   Log out of eMaRC Plus 

The Administration Menu 

The Administration menu is used to access the administrative features of the program, such as 

managing user accounts, setting up the display type for auto-generated abstracts, and configuring 

system preferences. No toolbar icons or keystrokes are available for any Administration menu 

options.  To access the Administration menu items, click on the Administration menu item, and 

select the desired sub-option.  

 

 

The Physician Reporting module of eMaRC Plus differs from other 

Registry Plus applications in that entry of a special Administrator 

password is not required in order to access the Administration menu 

items.  The intent of the Physician Reporting module use is to be set up 

and run automatically in a production environment.  Unlike the ePath 

module of eMaRC Plus, review of individual CDA documents and 

abstracts will eventually not be necessary, as the module is programmed 

to be fully automated.  As many of the features of the application will 

be used for initial testing and setup, there is only a single User role that 

has access to all menu items. 

 

The following table describes the Physician Reporting module Administration menu sub-options: 

Sub-option Function 

Manage Users… 
Add, edit, or delete a user account or reset a 

password   

Manage Abstract Display… 

Create or edit the display type used when auto-

generating abstracts from imported CDA 

documents, and for display of NAACCR data 

items on the CDA workbench   

Manage Document Display… 

Manage the CDA document data that is 

displayed and how it is displayed on the CDA 

workbench 
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Sub-option Function 

Manage Import Documents 
Delete imported CDA documents from the 

system 

Manage Facility 
Ability to add/update and add multiple NPI 

numbers to one facility.  

Application Configuration… 
Set the name of your central registry on 

generated reports.   

The Help Menu 

The Help menu is used to access the User’s Guide that comes with the program, as well as 

viewing important versioning and contact information.  No toolbar icons or keystrokes are 

available for any Help menu options.  To access the Help menu items, click on the Help menu 

item, and select the desired sub-option.  

 

The following table describes the Physician Reporting modules Help menu sub-options: 

Sub-option  Function 

User’s Manual 
View the contents of the eMaRC Plus Physician 

Reporting Module User’s Guide 

About… 
View important application versioning and contact 

information 

The Main Window Toolbar Icons 

As mentioned earlier, the Import Physician Reports, Open Physician Reports and Export 

Abstract functions are available via both the File menu item and icons on the toolbar.  However, 

some functions are available only through toolbar icons. To access any of the functions offered 

on the toolbar, simply click the icon for the function you would like to use. 

Functions available via the File menu item and toolbar icons: 

 

Functions available only via toolbar icons: 

  

The following table describes the Physician Reporting module toolbar icons for those functions 

available only via toolbar icons: 

Toolbar Icon  Function 
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Toolbar Icon  Function 

PHINMS Queue 
View CDA documents residing in the PHINMS queue, 

review for import errors, and export documents as desired 

Search 

Apply user-specified search parameters to dynamically 

generate a batch of CDA documents to open and review 

within the CDA Workbench 

Raw Data 

When a CDA document is open on the CDA workbench, 

click to view the CDA document in one of 2 ways: 

• The raw CDA document display in XML format, 

which is searchable by user-specified terms 

• The tree view display which is searchable by xpath 

Reports 

Click to view submission monitoring reports as well as a 

report documenting the Abstract Display, which can be 

very helpful when making revisions to the display type, 

and for display type documentation purposes 

Generating a User Account 

As mentioned earlier, upon initial launch of the program, you will be prompted to enter the 

default User ID of doe, the default password of guest to log into the application. Once you have 

logged into the application, you will need to generate a new user account for yourself. 

To create a new user account for the eMaRC Plus Physician Reporting module, complete these 

steps: 

1. Launch eMaRC Plus and log in to the eMaRC Plus Physician Reporting module. 

Result: The main eMaRC Plus Physician Reporting window opens. 
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2. Open the Manage User window: 

a. From the Administration menu, select Manage Users…  

 

Result: The Manage User window opens: 
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3. Click Add. 

Result: The Add User window opens. 

 

4. Enter a User Name in the User Name field, and press the Tab key. In the example shown the 

user name being entered is New User. 

Result: The cursor will move to the User ID field. 
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5. Enter a 3 character User ID in the User ID field, and press the Tab key. In the example 

shown the User ID being entered is NAU. 

Result: The cursor will move to the Password field. 

 

6. Enter a Password in the Password field and Click OK. 

Result: You are returned to the Manage User window, where our new user account is 

displayed. 

 

7. Click OK. 

Result: You are returned to the main eMaRC Plus Physician Reporting window. 

 

To delete a user account, simply select the User Name from the list on 

the left and click Delete. 
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Changing your Password 

For security purposes, you may be required to change your general user password periodically, 

based on your registry’s password requirements. 

To change your password for your eMaRC Plus Physician Reporting module user account, 

complete these steps: 

1. Open the Manage User window: 

b. From the Administration menu, select Manage Users…  

 

Result: The Manage User window opens: 

 

2. Select your name from the list of users on the left and click Change Password. 

 
A user is only permitted to change their own password. 
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Result: The Change Password window opens. 

 

3. Enter your new password in the Enter password field and re-enter your new password in 

the Re-enter password field. The passwords must match, including capitalization and use of 

special characters. 

 

4. Click OK. 

Result: you are returned to the Manage User window with your password successfully 

changed. 
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5. Click OK. 

Result: You are returned to the main eMaRC Plus Physician Reporting window. 

 

Deleting a User Account 

To delete a user account from the eMaRC Plus Physician Reporting module, complete these 

steps: 

1. Open the Manage User window. From the Administration menu, select Manage Users…  

 

Result: The Manage User window opens: 
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2. Select the name of the user to be deleted from the list of users on the left and click Delete. 

Result: The application asks you to confirm the deletion of the selected user account.  

 

3. Click Yes. 

Result: The user account is deleted from the application.  

 

Viewing Versioning and Contact Information 

To view eMaRC Plus CDA module versioning and contact information, complete these steps: 

1. From the Help menu, select About… 

 

Result: A window opens with information about the application and database versions, as 

well as important contact information. 
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2. Click OK to close the About window. 

Logging Out 

When logging out of and exiting eMaRC Plus, the application will ask you if you are sure you 

want to exit the program. 

To log off /exit eMaRC Plus, complete these steps: 

1. Exit eMaRC Plus.  This can be done in 2 ways: 

a. Click on the File menu, and select Exit. 

 

b. Click the X in upper right corner of screen. 
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Result: The Close Application window opens, and asks if you are sure you want to exit the 

program. 

 

2. Click Yes. 

Result: The eMaRC Plus application closes. 

 

 

If you are logged into the Physician Reporting module and would like to 

switch to the ePath module, you must log out of eMaRC Plus and log back 

in, selecting the module within which you would like to work. 
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Chapter 3: Data Processing Flow  

Learning Objectives 

In this chapter, you will: 

• Be made aware of data pre-processing requirements that must be carried out prior to 

importing CDA documents into the eMaRC Plus Physician Reporting module 

• Become familiar with application-specific terms and abbreviations in order to fully 

understand each step of data processing  

• Learn how CDA documents are automatically processed through the application to 

generate abstracts in the NAACCR record layout for data exchange including: 

− Storing of CDA document data into associated section tables 

− Defaulting of values for NAACCR data items for which the CDA documents does 

not contain information 

− Mapping of values from the CDA document to the associated NAACCR data item 

− Translating values in the CDA document to the standard NAACCR data item 

codes and format 

− The Multiple Record Management Process by which information included in 

multiple CDA documents received by the central cancer registry from the same 

reporting entity for the same patient and tumor will be automatically processed 

and consolidated in eMaRC Plus  

• Learn about the purpose of the Processing Log and when and what type of warning 

messages get written to it 

Overview 

This chapter covers the basics of the eMaRC Plus Physician Reporting module. You’ll learn 

about data pre-processing requirements, all of the ongoing, automated data processing that 

occurs in the module, and about what the Processing Log is.  

Data Pre-processing Requirements 

Prior to submitting data to a central cancer registry all EHR vendors MUST complete the testing 

and validation process with the Office of the National Coordinator - Authorized Testing and 

EHR Certification Bodies (ONC-ATCBs) to receive the required MU certifications.  In addition, 

CDA documents received by central cancer registries from EHR vendors should be validated by 

CDA Validation Plus.  CDA Validation Plus is a part of the Registry Plus software suite of 

publicly available free software programs for collecting and processing cancer registry data 

developed by CDC. CDA Validation Plus is a tool used to validate the structure, content, codes, 

and coding systems of CDA documents (based on XML) that are generated by EMR/EHR 

software systems and submitted to central cancer registries specifically for the purposes of 

cancer reporting. The application is used by EMR/EHR vendors to validate cancer CDA 

documents generated by their products and by central cancer registries to validate cancer CDA 
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documents during the on-boarding process for providers and prior to subsequent processing in 

the Physician reporting module of eMaRC Plus.  

CDA Validation Plus performs validations based on the specifications in the Implementation 

Guide for Ambulatory Healthcare Provider Reporting to Central Cancer Registries, August 2012, 

Release 1.0 (“Cancer IG”), the standard identified for the MU Stage 2 cancer reporting objective 

and HL7 CDA ® Release 2 Implementation Guide: Reporting to Public Health Cancer Registries 

from Ambulatory Healthcare Providers, Release 1, DSTU Release 1.1 – US Realm, the standard 

identified for the MU Stage 3 cancer reporting objective.   

 

Glossary of Terms/Abbreviations 

Cancer CDA document: The NAACCR Physician Reporting workgroup-specified Clinical 

Document Architecture document reported by the physician EHR to the central cancer registry. 

CDA is an XML document that consists of a header and a structured body. It is presented in this 

format: Header – includes patient information, author, creation date, document type, provider, 

etc. Body – includes diagnosis, patient details, medications, procedures, follow-up, etc. 

Information can be presented as free text in one or multiple sections, and also includes coded 

entries. 

Major Components of a CDA document: 

− A CDA document has a Header and a Body. 

− A CDA document Body is comprised of Sections. 

− A CDA Section contains one Narrative Block and zero to many Entries. 

o [1..1] Header 

o [1..1] Body 

− [1..*] Sections 

▪ [1..1] Narrative block 

▪ [0..*] Entries 

https://www.cdc.gov/phin/resources/guides/documents/implementation_guide_for_ambulatory_healthcare_provider_reporting_to_central_cancer_registries_march_2014.pdf
https://www.cdc.gov/phin/resources/guides/documents/implementation_guide_for_ambulatory_healthcare_provider_reporting_to_central_cancer_registries_march_2014.pdf
https://www.cdc.gov/phin/resources/guides/documents/implementation_guide_for_ambulatory_healthcare_provider_reporting_to_central_cancer_registries_march_2014.pdf
http://www.hl7.org/implement/standards/product_brief.cfm?product_id=398
http://www.hl7.org/implement/standards/product_brief.cfm?product_id=398
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Example of CDA XML Format Structure: 

  

Section Record:  A set of related data elements populated from the CDA document grouped by 

the various sections of the CDA document. 

Section Table: The eMaRC Plus database location where section records are stored.  There will 

be a section table for each set of related data elements, e.g., Demographic, Address, Payer, Social 

History, Cancer Diagnosis, Problems, Procedures, Results, Medications, etc. 

CDA Document ID: A unique number assigned by the reporting entity that uniquely identifies 

the CDA document. 

CDA Data Element Name:  The name of the field in the CDA document. 

CDA Cancer Diagnosis Entry: The component of the CDA document that contains the 

information about the patient’s cancer (Diagnosis date, site, laterality histology, etc.). 

NAACCR Data Item Name:  The name of the mapped data item in the current NAACCR 

Standards for Cancer Registries, Volume II, Data Standards and Data Dictionary Record Layout. 

The NAACCR Data Item Number follows the Data Item Name in brackets, e.g., Date of Birth 

[#240]. 

Mapping:  Transferring a data element in the CDA document as-is to a NAACCR data item in 

the NAACCR Record Layout. 

Translating: Converting a data element value in the CDA document to the appropriate value 

NAACCR data item value via translation tables and/or algorithms. 

Defaulting: Specifying a default value for any NAACCR data items for which the CDA 

document includes no information and can therefore not be populated with a value using 

information from the CDA document.  

NAACCR Abstract Values: Coded values and textual information resulting from of a 

combination of mapping and translating to, and defaulting of coded NAACCR data items and 
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text fields from the Section Records (generated from the CDA document) using NAACCR 

coding conventions.   

Abstract Reference Identifier (AbsRefID): A permanent unique identifier assigned to each 

NAACCR abstract generated by eMaRC Plus from imported CDA documents. 

Facility Abstracts Table: The eMaRC Plus database location where mapped, translated, and 

defaulted NAACCR data item coded values and text fields are stored for each Section record 

generated by eMaRC Plus from imported CDA documents. 

Processing Log: Document generated that includes warning messages and details pertinent to 

the mapping/translation process. Registries may choose to review this log and make corrections 

in eMaRC Plus or address any identified issues within the central registry software. 

Multiple Record Management: The process by which information included in multiple CDA 

records received by the central cancer registry from the same reporting entity for the same 

patient and tumor will be automatically processed in eMaRC Plus.  Although manual review of 

certain records may be suggested by information included in the Processing Log; no manual 

intervention will be required in eMaRC Plus (registries may choose to address identified issues 

in the central registry software). 

Consolidated Abstract Values: Using the Multiple Record Management process (see Section 

2), eMaRC Plus will automatically generate consolidated coded values/text from multiple 

NAACCR Abstract Values mapped from the same reporting entity for the same patient and 

tumor. The best Consolidated Value will be automatically determined on a data item by data item 

basis for all NAACCR data items to be consolidated across all Abstract Values 

mapped/translated from all CDA documents received. Consolidation is an on-going process as 

new reports are received. 

Patient/Tumor/Reporting Entity Identifier (PTRID): A permanent unique identifier assigned 

to all abstract entries in the Facility and Consolidated abstracts tables for CDA records received 

from the same reporting entity for the same patient and tumor. 

Consolidated Abstracts Table: The eMaRC Plus database location where consolidated 

NAACCR abstract values from multiple abstract values mapped from the same reporting entity 

for the same patient and tumor are stored. 

NAACCR Abstract: An abstract in standard NAACCR file format generated upon export of 

initially reported or consolidated abstracts out of eMaRC Plus: 

Initially Reported Abstract: The abstract mapped from the first CDA report received from a 

reporting entity for a specific patient and tumor. eMaRC Plus will automatically generate 

Initially Reported Abstracts upon export from eMaRC Plus when specified by the user. 

Consolidated Abstract: The abstract that is the culmination of the Multiple Record 

Management process (see Section 2 below). eMaRC Plus will automatically generate 

Consolidated Abstracts upon export from eMaRC Plus when specified by the user.   
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Technical Specifications 
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Data Flow Detailed Description 

1. Save CDA Records and Generate Section Records and NAACCR Abstract Values 

1.1. Store originally submitted CDA document 

All validation of CDA structure, content, codes systems will be performed using the 

Validation Tool prior to processing a CDA document within eMaRC Plus. An archived 

copy of the CDA document as originally submitted will be stored as a blob in a table in 

the eMaRC Plus database. eMaRC Plus provides functionality to archive and/or purge 

these documents as they accumulate over time.  

1.2. Identify single or multiple cancer diagnoses included in the CDA document; For 

each cancer diagnosis represented in the CDA document do the following: 

1.2.1. Generate Section Record(s) in Section Table(s) with original CDA information 

parsed out into Section Records and stored in associated Section Tables  

For each Cancer Diagnosis Entry in the CDA document CDA data elements will be 

parsed out and Section Records will be generated which are stored in the 

appropriate Section Tables. 

Section Record Tables store the data elements (or groups of related elements such 

as address) as individual rows. Section Tables include the data element, identifiers, 

value, code, code system, and other supporting information about the data element. 

They will all be linked to the same CDA document through the CDA Document 

ID. All Section Tables have a naming convention of DATA_ in the eMaRC Plus 

database. Please see Appendix A for documentation of the various Section Tables 

and the records and data with which they are populated. 

Section Records include the CDA information to be mapped and translated as well 

as supplemental information that has no associated NAACCR data item, such as 

medication Name and Route of Administration. Separate rows are inserted into a 

table for elements that are repeated in the CDA document so that historical 

information is retained. For example, if multiple addresses for a patient are 

provided in a single CDA report, each address will create a separate row in the 

Address Section Table. Other examples include occupation and industry.  Please 

see Appendix A for documentation of each of the Section Tables in the eMaRC 

Plus database and the data that they store. 

If multiple cancer diagnoses exist within the CDA record, multiple Section 

Records will be generated. In the event that the CDA document includes multiple 

cancer Diagnosis Entries but does not provide any method of linkage between each 

Cancer Diagnosis Entry and data in other sections, then all data elements will be 

repeated in each Section Record generated. 

1.2.2. Map/Translate CDA code values and textual information to NAACCR-coded 

data item values and text fields; Default values are set by user within the 

display type, and can be hidden where appropriate 

eMaRC Plus parses out individual data elements and textual information from each 

CDA document and maps each element to a corresponding NAACCR data item 

and/or text field when one exists. If a central registry wants to map supplemental 
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information in the CDA document to a non-standard data item, this data item will 

be defined as a state-specific data item in the State/Requestor area of the NAACCR 

record layout [#2220].  Each State-specific data item must be assigned a NAACCR 

Data Item Number in the range of 9550-9999, assigned to a columnar position(s) 

within the State/Requestor area (positions 2340 – 3339), and assigned a unique 

data item name.   

To minimize the onus on the cancer registry of receiving the new physician CDA 

reporting source data stream, all mapping has been fully automated; no manual 

review of mapped information is required within eMaRC Plus.  Defaulting, 

mapping, and translating of NAACCR data item values and text fields from the 

CDA document is accomplished using recommended user-specified default values 

(see Appendix B) and mapping and translation tables and rules (see Mapping and 

Translation Guide), developed by the Physician Reporting Workgroup. 

Reprocessing Files (New Feature!)  

Any files with diagnosis year of 2018 or later that were imported into eMaRC 

using version 6.0 were mapped to NAACCR Version 16.0 Record Layout. When 

upgrading eMaRC to version 7.0, the updater will automatically reprocess these 

files. Reprocessing will re-map content to NAACCR Version 18.0 Record Layout 

and apply other updated mapping and translation rules. A “Reprocess Selected” 

button has also been added as a new feature to enable users to manually reprocess 

files. To access, select Administration > Manage Import Documents.  

 

 

1.2.3. Generate Unique Abstract Reference Identifier (AbsRefID) and store 

NAACCR abstract values for each abstract in the Facility Abstracts Table; 

Flag initial report 

All NAACCR Abstract Values for individual NAACCR abstract entries will be 

generated from the Section Records containing mapped, translated, or defaulted 
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NAACCR Values and stored in the PHYSICIAN_FACILITYABSTRACT Table 

for each Cancer Diagnosis Entry with a unique AbsRefID assigned.  

When a CDA document has more than one Cancer Diagnosis Entry, eMaRC Plus 

will create a separate abstract entry in the Facility Abstracts Table for each cancer 

diagnosis. Due to the fact that linkage and coding of procedures, treatment, and 

results for each of the multiple cancer diagnoses could possibly be incorrect and 

may warrant manual review (either within eMaRC Plus or the central registry 

software), eMaRC Plus will write a warning message to the Processing Log to 

indicate that multiple abstracts have been created representing the Multiple Cancer 

Diagnosis Entries.  

It is quite possible that multiple CDA reports may be received from the same 

reporting entity for the same patient and tumor.  eMaRC Plus assigns the abstract 

mapped from the first CDA report received a special “Initial Report” status code, 

enabling the registry to export the initial report, which may not be complete, for 

the purposes of Rapid Case Ascertainment (RCA), follow-back, etc.. A more 

complete consolidated abstract may be exported at a later date if desired (see 

Multiple Record Management, Section 2).    

2. Multiple Record Management  

2.1. Apply matching algorithm for identifying subsequent reports from the same 

reporting entity for the same patient and tumor 

After receiving an initial CDA document for a patient and tumor from a particular 

reporting entity, eMaRC Plus will include a matching algorithm to identify and link any 

subsequent reports from that same facility for that patient and tumor. The matching 

algorithm will be applied to the following mapped NAACCR Data Item Values: 

Medical Record Number [#2300] (patient identifier from the physician office), Date of 

Birth [#240], Social Security Number [#2320], Primary Site [#400], Behavior [#523], 

Histologic Type [#522], Laterality [#410], Diagnosis Date [#390], and NPI—Reporting 

Facility [#545]. 

The matching of tumor information will be accomplished using the TLC Plus (Tumor 

Linkage and Consolidation) logic utilized in the Registry Plus CRS Plus application, 

which is currently being enhanced to include automatic identification of the same tumor 

using the SEER Multiple Primary and Histology (MPH) rules.  In the enhanced version, 

the set of directives (or “rules”) that apply to a specific set of site/type combinations is 

called a rule set.  At this time, we anticipate preparing rules sets to correspond to the 

following categories used in the SEER MPH rules:  Head and Neck, Colon, Lung, 

Cutaneous Melanoma, Breast, Kidney, Renal Pelvis, Ureter, Bladder, and Other Urinary, 

Malignant Meninges, Brain, Spinal Cord, Cranial Nerves, Pituitary Gland, 

Craniopharyngeal Duct and Pineal Gland [Malignant Brain], Benign and Borderline 

Intracranial and CNS Tumors [Benign Brain], and Other sites. 

Rule sets are being developed that will utilize the Site Pairs table, the generic HistoPairs 

table, any rule-set specific pairs (e.g., for Colon, pairs with a histology code indicating a 

polyp are handled differently than for other rule sets), as well as the time interval 
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between dates of diagnosis. The majority of MPH rules will be incorporated as time and 

resources allow.  

In the meantime, a tumor will be deemed a match if all 4 characters of the ICD-O-3 

Topography code, Behavior, Histologic Type, Laterality, and Diagnosis Date (within 

one month) are a match.  This will result in a conservative approach which may generate 

separate abstract entries in the Facility Abstracts Table for subsequent reports received 

for the same patient and tumor from the same reporting entity. However, as the reports 

being linked are from the same reporting entity for the same patient and tumor, it is 

unlikely that these values will vary on subsequent reports with great frequency. Until the 

Enhanced MPH Tumor Linkage algorithms are developed and implemented in eMaRC 

Plus, it is anticipated that erroneously separated reports can be consolidated in the 

central registry software. 

2.2. Assign a unique Patient/Tumor/Reporting Entity identifier (PTRID) to all abstracts 

in the Facility Abstracts and Consolidated Abstracts Tables for reports from the 

same reporting entity for the same patient and tumor  

When the matching algorithm identifies any subsequent reports from the same facility 

for the same patient and tumor, a permanent unique Patient/Tumor/Reporting Entity 

identifier (PTRID) will be assigned to the initial abstract entry and all abstracts based 

upon subsequent reports in the PHYSICIAN_FACILITYABSTRACT Table as well as 

the consolidated abstract in the PHYSICIAN_CONSOLIDATEDABSTRACT 

Table.   

2.3. Auto-generate consolidated abstract values from multiple abstracts mapped from 

multiple CDA documents received from the same reporting entity for the same 

patient and tumor 

2.3.1. Apply modified Registry Plus consolidation directives on a data item by data 

item basis to all NAACCR data items across all abstracts generated from the 

same reporting entity for the same patient and tumor 

The Registry Plus Central Registry Software (CRS Plus) has an extensive interface 

to answer the question, given multiple reports on the same patient and tumor, what 

is the best value for each data item to be stored in a consolidated record for the 

patient and for the tumor?  

To complete data item consolidation, CRS Plus applies consolidation directives 

or automated “rules” for each data item.  Consolidation directives define how data 

from two or more linked records are evaluated to select a final "best" value for 

each data item in the consolidated record.  Consolidation compares values from the 

incoming record and all historical abstracts for the PTRID (the consolidated value 

is not utilized).    

Directives may be used alone or in sequence to define an automated consolidation 

rule for each field.  In CRS Plus, sequenced directives are applied in user-defined 

order until a consolidation decision is reached (only one value remains) or all 

directives are exhausted.  When a string of directives is completed with no single 

value remaining, the record is placed in the CRS Plus pending file for manual 

review.  However, the failure of a single field does not halt the consolidation 
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process.  All fields proceed through the consolidation process with an outcome of 

a selected consolidated data value or manual review.   

Modified consolidation directives have been developed for the CDA module of 

eMaRC Plus that address 2 factors: 1) all abstract values to be consolidated will 

be reported by the same facility, and 2) all directives will successfully 

consolidate data items so that no manual review is required.   Thus no manual 

process will be needed for processing multiple reports on the same patient and 

tumor from the same provider. 

To illustrate a successful consolidation directive requiring no manual review, the 

consolidation rule for Social Security Number [#2320] (SSN) is to select a known 

value over unknown, otherwise select the value occurring most frequently, 

otherwise select the value from the abstract with the most recent patient contact.  

This consolidation rule appears in directive form as:  

‘KnownOverUnknown;MostFrequent;MostRecent’.  The following example 

illustrates how the consolidated SSN value is selected through the application of 

these directives: 

  AbsRefID   SocSecNum DateLastContact 

  00000012   123456789 01/14/2013 

  00000301   987654321 01/15/2013     

  00000459   999999999 01/15/2013 

  00001010   123456789 01/24/2013 

  00002330   987654321 02/15/2013 

Selected Value: 987654321  

(99999999 eliminated as unknown value.  Since 123456789 and 987654321 both 

occur twice, the value from abstract 00002330 is automatically selected based on 

the most recent Date of Last Contact).   

As subsequent CDA documents are received for the same PTRID, data values for 

individual data items are compared and consolidation directives are applied to 

determine the best Consolidated Abstract Values to be stored in the in the 

Consolidated Abstracts Table; Consolidated Abstract Values will be continually 

and automatically updated with any new or revised information in the Abstract 

Values generated from the subsequent reports.  

There is a library of general-purpose directives that can be selected.  Directives are 

written in a special purpose vocabulary and syntax created for Registry Plus.  

Individual directives can be strung together and are then applied to data values in 

the specified order until only one data value remains. Please see the separate guide 

for a complete listing of individual eMaRC Plus CDA Module consolidation 

directives and their definitions.  

2.3.2. Automatically determine best values for the consolidated abstract 

As stated above, all consolidation directives for data items to be consolidated 

across multiple Abstract Values in the Facility Abstracts Table will be modified so 

that no manual review is ever required and all consolidation will occur 
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automatically. Currently, in the CDA Module of eMaRC Plus all fields that are 

included in the TblConsolidationRules table in the pathlab.mdb with an active 

status of “1” are being consolidated.  If no consolidation directives exist for a 

particular data item, the Abstract Values from the initial abstract entry are retained 

in the PHYSICIAN_CONSOLIDATEDABSTRACT Table and never get updated 

by the automated consolidation process. Please see eMaRC Plus Physician 

Reporting_Consolidation Directives for a listing of selected columns of the 

eMaRC Plus CDA Module TblConsolidationRules table for the individual 

directives and directive strings currently specified for fields being automatically 

consolidated. The TblConsolidationRules table also defines unknown values for 

data items which include the KnownOverUnknown consolidation directive. 

2.3.3. Store/update Consolidated Abstract Values in the Consolidated Abstracts 

Table 

As subsequent CDA documents are received for the same patient and tumor from 

the same reporting facility, the Consolidated Abstract Values in the 

PHYSICIAN_CONSOLIDATEDABSTRACT Table will be continually and 

automatically updated with any new or revised information in the Abstract Values 

generated from the subsequent reports. 

Section 2 Summary: This Multiple Record Management process along with highly-specific 

abstract export options (see Section 3) will accommodate registries that carry out RCA, or intend 

to follow-back on the initial report received, and/or allow the registry to wait a user-specified 

time period prior to exporting a single, consolidated (assumedly more complete) abstract. 

3. Export Initially Received and/or Consolidated Abstracts 

3.1. Apply user-specified parameters for exporting both initially received abstracts 

and/or subsequently consolidated abstracts in NAACCR Record Layout format 

Export can be carried out manually or automatically from the DOS command Line. The 

Export Abstracts window allows for highly-specific export of abstracts to include only 

those abstracts of interest to the central registry. 

3.2. Export abstracts for subsequent import into central registry database or follow-

back system; Exported Abstracts will be grouped into separate files using 

Reporting Facility [#540] 

Regardless of any of the Specific Export Options selected (excluding the Export All 

Options) all abstracts exported out of the eMaRC Plus CDA module are in the NAACCR 

Record Type A format and are grouped into separate files by the mapped Reporting 

Facility ID. Users can utilize the File Save Option to specify whether or not they would 

like to manually enter a filename for each exported file of abstracts or if they would like 

eMaRC Plus to automatically name each exported file of abstracts using the Reporting 

Facility ID.  

The PTRID will be exported with each abstract, enabling the central registry to link back 

to the eMaRC Plus CDA database for any patient or group of patients. The PTRID will 

be 10 characters in length and located in positions 20911 to 20920 in the NAACCR 

Record Layout in abstracts exported out of the eMaRC Plus CDA module. 
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Please note:  Currently the only export of data from eMaRC Plus that is supported by a 

user interface is the export of NAACCR abstracts in the NAACCR Record Layout.  As a 

result, extraction of original CDA information stored in Section Records and Tables can 

be achieved by querying the eMaRC Plus database.  A relational key exists in each 

table/record that that can be used to link the various tables, as shown below.  

 

A separate interface for directly querying the database may be considered for a future 

release. 
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Chapter 4: Importing CDA Documents 

Learning Objectives 

In this chapter, you will learn to: 

• Manually import CDA documents into the Physician Reporting module of eMaRC Plus 

• Check for and import CDA documents from the PHINMS queue  

• Check for and import CDA documents from a user-specified folder 

• Review any errors occurring upon import of CDA document 

Overview 

This chapter covers the import of CDA documents into the Physician Reporting module of 

eMaRC Plus.  You can import CDA documents in three ways: manually, from PHINMS, or from 

a user-specified folder. 

Importing Physician Reports Manually 

Although CDA documents can be loaded automatically from a designated folder through or via 

the PHINMS queue, you may find yourself in a situation where you need to manually import 

CDA documents. 

To import CDA documents manually, complete these steps: 

1. Open the Open File window.  This can be done in 3 ways: 

a. Click on the File menu, and select Import Physician Reports. 

 

b. Use the keystroke Ctrl+N.  

c. Click the Import Physician Reports    icon on the toolbar. 

Result: The Open File window opens. 
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2. Navigate to the CDA document on your computer or network, select the file and click 

Open. In the example shown, a CDA document named Test sample for physician.xml is 

being imported. 

Result: The application lets you know that it is importing the file. 

 

Upon successful import the original CDA document will be stored in a “blob” in the eMaRC 

Plus database, will be automatically processed through all of the detailed Data Flow steps, 

and all of the appropriate fields in the Section, Facility Abstracts, and Consolidated Abstracts 

Tables will be populated.  Once the import has completed, you are returned to the eMaRC 

Plus Physician Module main window, where you can proceed to use any of the available 

functions, or choose to manually import additional files. 

Poll and Import Physician Reports from PHINMS Queue 

More commonly, multiple CDA documents will be automatically imported sequentially. If your 

state is receiving Physician reports via PHINMS, you can poll the PHINMS Queue for any CDA 

documents awaiting import. 

To check for and import CDA documents from the PHINMS queue, complete these steps: 

1. Click on the File menu, and select Poll and Import Physician Reports from PHINMS 

Queue. 
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Result: The Automated Import window opens, and the application checks the PHINMS 

queue table in the eMaRC Plus database for any new CDA documents received that may be 

waiting for import. 

 

The Automated Import window stays open until the application finds a CDA document in the 

PHINMS queue table to import, when it finds a file to import, the application lets you know 

that it is importing the file. 

 

Upon successful import the original CDA document will be stored in a “blob” in the eMaRC 

Plus database, will be automatically processed through all of the detailed Data Flow steps, 

and all of the appropriate fields in the Section, Facility Abstracts, and Consolidated Abstracts 

Tables will be populated.   

In addition, the file in the PHINMS Queue table will be flagged as imported to prevent 

redundant importing of the same CDA document. At this point, the Automated Import 

window re-opens, and the application checks the PHINMS queue table in the eMaRC Plus 

database for any other new CDA documents received that have not been flagged as imported. 
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Again, the Automated Import window stays open until the application finds a CDA document 

in the PHINMS Queue table that has not yet been imported, and then the following window 

is displayed to let you know when the file is being imported: 

  

A reiterative process occurs; every few seconds the application will check the PHINMS 

Queue table in the database to see if there are any new documents to import and will import 

them one at a time. 

 

Once initiated, this process reiterates until Abort is clicked on the Automated 

Import window.  As a result, States using PHINMS can have this feature running 

in the background all of the time for 24 hours 7 days a week, to continually poll 

for any new documents received and automatically import and process them. 

2. Click Abort to stop the polling and import process. 

Result: You are returned to the eMaRC Plus Physician Module main window, where you can 

proceed to use any of the available functions. 

Viewing PHINMS Queue for Import Errors 

If the import of a CDA document from the PHINMS Queue encounters an error, eMaRC Plus 

will open a window with the error displayed to allow the user review the error, and then click 

OK to close the error message window. However, the application allows the user to view CDA 

documents residing in the PHINMS queue, review for import errors, and export errant 

documents as desired.  

To obtain more information on the import error, and be able to export the errant CDA document, 

complete these steps: 

1. Click on the PHINMS Queue  icon on the toolbar. 

Result:  The PHINMS Queue window opens, and displays all CDA documents in the 

PHINMS queue, with each row representing an individual CDA document.  The documents 

that were unsuccessfully imported will have the error displayed in the ApplicationStatus 

column to facilitate the trouble-shooting of the error. 
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In general, this window is used only for troubleshooting purposes on the rare occurrence of an 

error when eMaRC Plus tries to import from the PHINMSQUEUE, To investigate the error, 

this window allows files to be exported out of the table, and also allows the user to examine the 

other columns of the PHINMS Queue table in the database.  

2. To export a document for further examination, select the row corresponding to the DCDA 

document you would like to export and click Export. 

Result:  The selected file will be exported. Please note that you can export only one file at a 

time. 

Poll and Import Physician Reports from Folder 

As mentioned earlier, multiple CDA documents can be sequentially imported automatically 

rather than manually. You can automatically import CDA documents via PHINMS if your state 

has PHINMS set up, or if not, you can specify and utilize a folder for the application to 

automatically poll for any CDA documents awaiting import (see Managing System 

Configuration Settings, in Chapter 7 of the is manual). 

To check for and import CDA documents from a specified folder, complete these steps: 

1. Click on the File menu, and select Poll and Import Physician Reports from Folder. 

 

Result: The Automated Import window opens, and the application checks the folder 

specified upon setup of the application any new CDA documents received that may be 

waiting for import. 

 

 

The Automated Import window stays open until the application finds a CDA document in the 

folder to import and when it finds a file to import, the files will be removed from that folder. 
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If the file(s) have already been imported and are in the database, they will remain in the 

folder. eMaRC checks for files already imported (those with the same file name). 

When using the folder option for automatic import, upon successful import the original 

CDA document will be moved from the folder to an Archive folder (specified upon setup 

of the application) to prevent redundant importing of the same CDA document. The 

document is also stored as a “blob” in the eMaRC Plus database, and will be automatically 

processed through all of the detailed Data Flow steps, and all of the appropriate fields in the 

Section, Facility Abstracts, and Consolidated Abstracts Tables will be populated.   

As with automated import via PHINMS, at this point the Automated Import window re-

opens, and the application checks the specified folder for any other new CDA documents 

loaded into the folder. As with the PHINMS option, a reiterative process occurs; every few 

seconds the application will check the folder see if there are any new documents to import 

and will import them one at a time. 

 

Once initiated, this process reiterates until Abort is clicked on in the Automated 

Import window.  As a result, you can have this feature running in the 

background for 24 hours 7 days a week, to continually check for any new 

documents received and automatically import and process them. 

2. Click Abort to stop the polling and import process. 

Result: You are returned to the eMaRC Plus Physician Module main window, where you can 

proceed to use any of the available functions. 
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Chapter 5: Automatically Importing Using DOS 
Command 

Learning Objectives 

In this chapter, you will learn to: 

• Use the DOS Command Line to automatically import cancer CDA documents using the 

DOS Command Line.  

Overview 

This chapter covers instructions regarding running commands from the DOS prompt to import 

CDA documents.  These imports can be scheduled so that they run automatically at a specified 

time.  

Running Physician Imports from the DOS Command Line  

 

1. The command line interface can be used to import HL7 files, PIPE delimited file, and 

PHINMS Queue. 

2. If you are importing from a folder structure: 

a. We recommend that the source folder name DOES NOT contain spaces. The 

command line will not run properly.  

i. For example, you cannot have folder names like Documents/HL7 Files. 

Instead, name the folder Documents/HL7Files 

 

3. Importing files may take several minutes depending upon the size of the files. 

4. Some common mistakes are: 

a. Trying to import an already imported file 

b. Wrong file or format (e.g., Binary file) 

 

How to import data using command line interface 

1. Run command Prompt 

a. Windows XP user 

i. Click on Start, then select Run 

ii. Type cmd in “Open” input box and press enter 

b. Windows Vista/Windows 7/Windows server 2008 user 

i. Type cmd in the Vista Start Run box 
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ii. Use the keyboard shortcut combination Ctrl + Shift + Enter instead of just 

pressing Enter. 

iii. This will open the Command Prompt in Administrator mode. 

2. Once you are in command prompt 

a. Importing CDA Messages from a Folder  

i. Type CD\ and press enter key to get on root prompt (i.e. C:\ prompt) 

ii. Type CD eMaRCPlus (or other folder name where eMaRCplus.exe is 

located) and press enter key  

iii. Type the following command with parameters and press enter  

eMaRCPlus.exe  module=2 file=C:\YourFileLocation fileformat=CDA 

user=YourUserID pwd=YourPassword 

(Replace “C:\YourFileLocation” with the folder location that you would 

like to import from, “YourUserID” with your user ID, etc.) 
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Chapter 6: Opening/Searching/Viewing Records  

Learning Objectives 

In this chapter, you will learn: 

• How to open single or multiple CDA documents by manually selecting individual CDA 

documents from a list of all documents in the database and view CDA document(s) and 

NAACCR abstract(s) side-by-side on the CDA Workbench  

• How to search for and concurrently view a user-generated batch of CDA documents and 

NAACCR abstracts side-by-side on the CDA Workbench  

• About the various functions and features on the CDA Workbench and how to use them to 

review CDA documents and their associated auto-generated abstracts 

• About the purpose of the Processing Log and when and what type of warning messages 

get written to it 

• How to print displayed CDA document(s) 

• How to view the CDA document raw data 

• How to view/export automated abstract consolidation results 

• How to print displayed auto-generated abstract(s) 

• How to view and export automatic data item consolidation results 

 

Overview 

This chapter covers the basics of viewing and printing CDA documents and auto-generated 

abstracts in the eMaRC Plus Physician Reporting module. You’ll learn about the different ways 

you can open CDA documents and abstracts, about the CDA Workbench and all of its features, 

as well as the functions available for the CDA documents and abstracts being viewed. There are 

two ways to open Physician Reports for viewing in eMaRC Plus: 

• Opening individual CDA documents 

• Searching for and generating batches of CDA documents and abstracts for review 

Opening Individual Physician Reports 

To open individual CDA documents in the CDA Workbench, complete these steps: 

1. Open the Physician Reports (CDA documents) window.  This can be done in 3 ways: 

a. Click on the File menu, and select Open Physician Reports. 
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b. Use the keystroke Ctrl+O.  

c. Click the Open Physician Reports    icon on the toolbar. 

Result: The Physician Reports (CDA documents) window opens. 

 

The Physician Reports (CDA documents) window contains these columns for all of the CDA 

documents in the PHINMS Queue: 

Column Heading Description 

Import ID The eMaRC Plus internally-assigned number for the 

imported document 

Import Date A Date stamp of when the CDA document was imported 

into eMaRC Plus 

MU The Meaningful Use Implementation Guide version 

(MU2 or MU3) 

Patient Last Name Patient’s last name 

Patient First Name Patient’s first name 

Reporting Facility The name of the reporting facility that submitted the 

CDA document 

Diagnosis Date Date of diagnosis 

Histology Code The histology code value(s) in the CDA document 

Primary Site Code The primary site code value(s) in the CDA document 



eMaRC Plus Physician Reporting Module   Opening/Searching/Viewing Records 

Version 9.0, Aug 2022  43 

Column Heading Description 

Document ID The identifier (root and extension) of the imported CDA 

document 

Document Name/Path The name and file location of the imported CDA 

document 

Generated Date The date the sending facility generated the file 

 

The displayed CDA documents are sorted be descending Import Date/Time by 

default. To sort the listed documents by any of the other columns, click on the 

column header of your choice. One click will sort the documents in ascending 

order of the values in the column, two clicks will sort the documents in 

descending order of the values in the column. Additionally, the order of the 

columns can be rearranged by clicking and dragging a column to move it to a 

different location. 

 

If additional CDA documents are loaded into the application after you have 

opened the Physician Reports (CDA documents) window, simply click Refresh 

to view the new documents in the listing. Additionally, the window will default 

to displaying the last 200 reports imported. You can change this by: 1) checking 

the “Show All” box, which will display all of the CDA reports ever imported; 2) 

changing the number of records in the “View Last X Records” box; or 3) 

entering date ranges in the “Import Date Range” boxes:  

 

2. To view a CDA document and its associated auto-generated abstract in the CDA Workbench, 

double click the row of the document that you would like to open.  

 

Result: The selected CDA document and its associated auto-generated abstract are opened 

in the CDA Workbench. 
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The CDA Workbench 

 

Upon import of CDA documents into the Physician Reporting module of eMaRC Plus the  among 

many automated processing steps is the generation of NAACCR formatted abstract values that will 

eventually be exported out of the application in NAACCR file format.  The window which is used 

to review the CDA document and auto-generated abstract in a side-by-side fashion is called the 

CDA Workbench. 

When you open a CDA document, the workbench opens and displays the Physician CDA 

document on the left and the auto-generated abstract on the right. The display of CDA document 

information on the right is generated by parsing the information directly from the CDA 

document. The display of abstract information on the right is generated by the defaulting, 

mapping, and translation processes that run in the background upon import into the application. 

In the CDA document and abstract displayed above, an example of the application of a default 

value is shown in purple, an example of mapping is shown in blue, and an example of 

translation is shown in green. See Appendix B and the Mapping and Translation Guide for 

granular level details of the defaulting, mapping, and translation processes.  

When you left-click and hold your mouse on the vertical divider bar in the center of the 

window, a splitter is highlighted which you can drag to the left or right to resize the view 

CDA 

Document 

Auto-generated 

Abstract 

Can Resize 

Panes Using 

Splitter 

Mapped 

Values 

Translated 

Value 

Defaulted 

Value 
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of the CDA document information or abstract information, and the application remembers 

your last placement of the divider bar. 

As with all of the Registry Plus products, this interface is customizable; to a certain degree you 

can specify what CDA document data elements to display within the document window pane on 

the right, and the abstract window pane is basically a highly customizable “display type”, where 

the user can specify what fields to display in in what order, can group fields into sections with 

customized headers, and can set properties for each of the fields, such as default values. 

The icons located above the CDA document view apply to the CDA document.  When searching 

for and opening multiple CDA documents, you can use the Back  and Next  icons 

to navigate through the CDA documents in the user-generated batch of documents. You can click 

the Processing Log  icon to view any application-generated messages written to the 

processing Log upon import of the CDA document(s), and you can click the Print  icon to 

print the CDA document(s). The icons located over the Abstract view apply to the abstract.  You 

can print the abstract by clicking the Print  icon, and you can view abstract consolidation 

results for multiple abstracts generated from multiple CDA documents submitted for the same 

PTRID by clicking the View Merged Record Results  icon.  

 

Within the ePath Module, coders use the ePath Workbench to review or code 

additional data items such as tumor primary site, histology, and grade by 

reviewing the text of path reports. As the intent of the Physician Reporting 

Module is to be entirely automated, after initial set up, verification, and testing 

there will be virtually no need for use of the CDA workbench.   

The CDA Document Views 

To facilitate review of the information in the CDA document, the document can be viewed in 

two different formats, the Data View and the Stylesheet View.  

The Data View 

The parsed out CDA document information is displayed in the Data View by default.  The Data 

View displays the CDA data elements in a single, easy-to-read column.  
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The Stylesheet View 

To view the CDA document in the Stylesheet View, click on the  icon located 

above the CDA document view.  In order to display XML documents, it is necessary to have a 

mechanism to describe how the document should be displayed. One of these mechanisms is 

Cascading Style Sheets (CSS), but XSL (eXtensible Stylesheet Language) is the preferred style 

sheet language of XML, and XSL is far more sophisticated than the CSS used by HTML. XSL 

consists of two parts:1) a method for transforming XML documents, and 2) a method for 

formatting XML documents.  When viewing the CDA document using the Stylesheet mode the 

parsed out CDA document is displayed using the cda.xsl style sheet file. The Stylesheet View 

displays the CDA data elements in a user-friendly, nicely-formatted style which includes a 

hyperlinked Table of Contents to each section of the CDA document.  

 

 

The Stylesheet View must be used with caution. It only shows content from the 

“Narrative Text” portion of the CDA document. It is possible that the coded 

values in the CDA document will not always match the narrative text content, so 

both views should reviewed if their discrepancies. 
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Note that when viewing the CDA document in the Stylesheet View the 

 icon on the toolbar is replaced with the   icon.  To 

return to the Data View of the CDA document, click the  icon (and 

notice that the  icon on the toolbar is replaced with the 

 icon).   

The Processing Log 

During import of a CDA document into the eMaRC Plus Physician Reporting module, any 

warning messages and important details pertinent to the mapping/translation process are written 

to the Processing Log. Registries may choose to review this log and address any identified issues 

within the central registry software. The following table documents when and what types of 

messages are written to the Processing Log: 
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Section Issue to Document Processing Log Message 

Active Problems More than 10 Problems 

Code <code+displayName> not 

mapped…more than 10 Active 

problems submitted. 

Active Problems 

Code not included in the NAACCR 

list of acceptable 

Comorbidities/Complications and 

Secondary Diagnoses 

Code <code+displayName>  not 

mapped…code not included in 

the NAACCR list of acceptable 

Comorbid/Compl or Secondary 

Diagnoses 

Cancer Diagnosis 

ICD10 CM does not have the 

morphology codes that were in ICD9 

CM. Histology codes are derived from 

the ICD10 diagnosis codes 

Histology code was an ICD-10-

CM diagnosis code in CDA 

Report. Abstract has been 

populated with Histology Code 

derived from this code through 

crosswalk. 

Cancer Diagnosis 
Histology code null/missing; derived 

from primary site code 

Histology code was unknown or 

null in CDA Report. Abstract has 

been populated with Histology 

Code derived from CDA primary 

site code ([ICD9 or ICD10 CM] 

diagnosis code) through 

crosswalk. 

Cancer Diagnosis 

Behavior code null/missing; derived 

from histology or primary site code. 

Behavior code not provided but free 

text is provided; mapped to text field.  

Behavior code was unknown or 

null in CDA Report. Abstract has 

been populated with Behavior 

Code derived from CDA primary 

site code ([ICD9 or ICD10] CM 

diagnosis code) through 

crosswalk. 

Behavior code was unknown or 

null in CDA Report. Abstract has 

been populated with the fifth digit 

(Behavior Code) from the CDA 

Histologic Type. 

“Behavior code was unknown or 

null in CDA Report; original text 

behavior information is provided 

in Text--Histology Title 

[#2590].” 

Cancer Diagnosis 
Laterality code null/missing; derived 

from primary site code 

Laterality code was unknown or 

null in CDA Report. Abstract has 

been populated with Laterality 

derived from NAACCR Primary 

Site [(ICD10 CM diagnosis 

code)] through crosswalk 

Cancer Diagnosis Grade code not provided; derived Grade code was assigned from 
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Section Issue to Document Processing Log Message 

from histology code (6th digit) the Abstract’s histology code 

because it has grade as part of the 

definition. 

Cancer Diagnosis 

Diagnostic Confirmation null/missing 

but free text is provided; mapped to 

text field 

Diagnostic Confirmation code 

was unknown or null in CDA 

Report; original text Diagnostic 

Confirmation information is 

provided. 

Cancer Diagnosis 

Invalid value for TNM Clinical or 

Pathologic Stage Group in CDA 

document 

TNM [Clinical or Pathologic] 

Stage Group value cannot be 

translated. 

Cancer Diagnosis 

TNM Clinical or Pathologic Stage 

element is null/missing in CDA 

document or invalid value; defaults 

(99 or 88) are applied based on cancer 

type 

TNM [Clinical or Pathologic] 

Stage Group value of ‘99’ was 

derived based on primary 

site/histology because no value 

was present in CDA. 

 

TNM [Clinical or Pathologic] 

[Stage Group, T, N, or M] value 

of ’88’ was derived based on 

primary site/histology because no 

value was present in CDA and the 

site/histology does not have an 

AJCC schema. 

Payer Wrong coding system used 

An unexpected Payer Code 

System was used to provide payer 

information <Code System OID+ 

Code System Name> 

Procedures: 

RX-Summ 

RX-Hosp 

Procedure code is in the translation 

table but doesn’t match the tumor site 

Code <code+displayName> is a 

cancer-related procedure but is 

not expected treatment for this 

cancer. 

Procedures:  

RX-Summ 

RX-Hosp 

When there are multiple procedures in 

the same CDA document, eMaRC 

maps the one that translates to the 

most extensive FORDS code, and 

provides a message in the log 

indicating that a less extensive 

procedure also exists 

A procedure was submitted for 

this cancer that is less extensive 

than the Rx Summ--Surg Prim 

Site code. 

Procedures 

If procedure date or diagnosis date is 

null/missing, procedure code is not 

mapped 

No procedure date was provided 

for the procedure code [ ] or no 

diagnosis is for the cancer is 

available. 

Procedures 
If procedure date is more than one 

year after diagnosis date, procedure 

Procedure [ ] is more than one 

year after the cancer diagnosis 
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Section Issue to Document Processing Log Message 

code is not mapped date. 

Documented in the 

Procedures Rules 

Two or more abstracts created 

 

RULE: If there is more than one 

cancer diagnosis entry, eMaRC will 

write a message to the processing log 

to indicate that multiple abstracts have 

been created representing the multiple 

cancer diagnoses due to the fact that 

linkage and coding of procedures, 

treatment, and results for each of the 

multiple cancer diagnoses could 

possibly be incorrect and may warrant 

manual review (either within eMaRC 

Plus or the central registry software) 

Multiple Cancer Diagnosis 

entries found resulting in the 

creation of multiple abstracts. 

Procedures, medications, and 

radiation therapy may need 

review. 

Procedures 

RULE: If the cancer diagnosis is 

melanoma and the Active Problems 

Section contains one or more non-

melanoma invasive or in situ skin 

cancer codes (Codes 173.n or 2xx.x 

(ICD-9-CM) OR C43.n or Dxx.n 

(ICD-10-CM) then eMaRC will write 

a message to the processing log 

indicating that the procedure assigned 

to the melanoma diagnosis may have 

actually been performed on a different 

non-reportable skin cancer. 

The procedure assigned to the 

melanoma diagnosis may have 

actually been performed on a 

different non-reportable skin 

cancer. 

Procedures 

If more than one Radiation Regional 

code is provided in the Procedures 

Section, eMaRC maps the first 

instance in the CDA document to the 

Rad--Regional RX Modality NAACR 

item.   

Radiation Oncology – More than 

one radiation procedure code was 

submitted 

Radiation Oncology 

If radiation treatment date or cancer 

diagnosis date is null/missing, 

radiation code is not mapped 

No Radiation [Regional or Boost] 

Treatment Modality Date was 

provided or no Diagnosis Date is 

for the cancer is available 
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Section Issue to Document Processing Log Message 

Radiation Oncology 

If radiation treatment date is before or 

more than two years after cancer 

diagnosis date, radiation code is not 

mapped 

A Radiation [Regional or Boost] 

Treatment Modality code was 

submitted that occurred before 

the diagnosis date.  

Radiation Regional Treatment 

Modality is more than two years 

after the cancer diagnosis date.  

Radiation Oncology 
If radiation treatment code is not in 

the translation table, it is not mapped 

A Radiation [Regional or Boost] 

Treatment Modality code was 

submitted that is not in the 

RADIATIONTRANSLATION 

table 

Radiation Oncology 

If radiation treatment code is in the 

translation table but doesn’t match the 

tumor site, it is not mapped 

A Radiation [Regional or Boost] 

Treatment Modality code was 

submitted that does not 

correspond to the primary site 

Radiation Oncology 

If more than one Radiation treatment 

code is provided in the Radiation 

Oncology Section, eMaRC maps the 

first instance in the CDA document to 

the Rad--Regional RX Modality 

NAACR item.   

Radiation Oncology – More than 

one radiation [Regional or Boost] 

RX therapy code was submitted. 

Medications/Medications 

Administered 

If medication treatment date or cancer 

diagnosis date is null/missing, 

medication code is not mapped 

Medication [Code-DisplayName] 

was not used because either the 

Medication Start Date or the 

Diagnosis Date was unknown or 

null in CDA Report 
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Section Issue to Document Processing Log Message 

Medications/Medications 

Administered 

If medication treatment date or cancer 

diagnosis date is before or more than 

one year after diagnosis date, 

medication code is not mapped 

Medication [Code-DisplayName] 

was not used because the 

Medication Start Date is either 

before or more than one year after 

the Diagnosis Date. 

 

To view the Processing Log for an imported CDA document, complete these steps:  

1. Open the Physician Reports (CDA documents) window.  This can be done in three ways: 

a. Click on the File menu, and select Open Physician Reports. 

 

b. Use the keystroke Ctrl+O.  

c. Click the Open Physician Reports    icon on the toolbar. 

Result: The Physician Reports (CDA documents) window opens. 

2. Double-click the row of the CDA document for which you would like to view the 

processing log. 

Result: The CDA Workbench opens and displays the selected CDA document and its 

associated auto-generated abstract. 
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3. To view the Processing Log for the current CDA document, click the Processing Log 

 icon on the CDA document toolbar.  

Result: The Processing Log window opens. 

 

 

The Processing Log window contains these columns for each message written to the Log: 

Column Heading Description 

ID The eMaRC Plus internally-assigned number for the 

Processing Log message 

Code The numerical code representing the type of Processing Log 

message: 

1 = identified issue with data mapping 

2 = invalid code (not currently used) 

3 = identified issue with translation 

4 = Error encountered during consolidation  

5 = Indicates that the CDA document has 

multiple cancer diagnosis entries, and will have 

more than one abstract associated with it. 

Message The actual Processing Log message 

Date/Time A Date/Timestamp of when the Processing Log message 

was generated 
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Printing the CDA Document 

CDA document(s) can be printed in either of the view types provided: the Data View or the 

Stylesheet View. 

To print a CDA document, complete these steps: 

1. Open the CDA document of interest in the CDA Workbench. 

2. Select the desired view of the document, by clicking either the Data View   or 

View with Stylesheet  icon on the CDA document toolbar. 

3. Click the Print  icon on the CDA document toolbar.  

Result: The Windows Print dialog box will appear. 

 

4. Click Print to print the document.  

Viewing CDA Document Raw Data 

In addition to the Data and Stylesheet views of the CDA document, you can also view the raw 

data of the document.  

1. While the CDA document is open in the CDA Workbench, click the Raw Data 

 icon on the main eMaRC Plus window toolbar. 

Result:  The CDAView window opens, and by default displays the CDA document in 

its raw XML format on the Raw XML tab. A helpful text search in included on the 

window; in the event that any issues are identified in the document, or you would like 

to review specific data, you can search the document for a particular term. 



eMaRC Plus Physician Reporting Module   Opening/Searching/Viewing Records 

Version 9.0, Aug 2022  55 

 

 

2. Enter a search term in the Find box, and click Find. In the example shown, the term 

address is being searched for. 

Result: The first occurrence of the search term is located and highlighted in the raw 

XML message. To search for additional occurrences of the same search term, just 

keep clicking Find.  
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The CDAView window also provides the option of viewing the document using a Tree View 

structure, which greatly facilitates the viewing of the document.   

3. To view the raw message using the Tree View, on the CDAView window click the Tree 

View tab. 

Result:  The raw data of the CDA document is displayed in a tree view format.  

 

 

The Tree View option allows the user to search the CDA document for a specific XPath.  

4. To search for a specific Xpath, copy and paste the XPath into the XPath box and click 

Get Value. 

Result: The application displays the value for the specified XPath. 

 

 

Click OK. 

5. To close the CDAView window, click the X in upper right corner of the window. 



eMaRC Plus Physician Reporting Module   Opening/Searching/Viewing Records 

Version 9.0, Aug 2022  57 

  

 

The Abstract Display  

The Abstract Display on the CDA Workbench allows the user to review all of the automated 

defaulting, mapping and translating of information from the CDA document to the NAACCR file 

format and coding conventions. The data items included in the display are those that will be 

exported upon exporting of an abstract (initial or consolidated).  Note that to facilitate viewing, 

some fields that are defaulted (e.g., the various coding system data items) are also hidden from 

view. As a result, the data items will not be displayed within the Abstract grid, but the values 

will be included in any abstract exports. See Appendix B for a listing of of all data items in the 

Abstract Display that comes with the application, including those that are hidden from view. 
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As mentioned earlier, the intent of the Physician Reporting Module is to be entirely automated, 

so after initial set up, verification, and testing there will virtually be no need for use of the CDA 

workbench to review the abstracts.   

Printing Abstract Data 

In addition to CDA documents, the auto-generated abstracts can be also be printed. 

To print an abstract, complete these steps: 

1. Open the CDA document associated with the abstract of interest in the CDA Workbench. 

2. Click the Print  icon on the Abstract Display toolbar.  
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Result: The Windows Print dialog box will appear. 

 

3. Click Print to print the abstract.  

 

When you print an abstract, only the visible fields on the display type are printed 

out. System fields, such as Morph Coding Sys-Current [#470] (defaulted to 8), 

NAACCR Record Version [#50], etc., that have been defaulted and hidden from 

view are not printed, but ARE included in any abstract that is exported out of 

eMaRC Plus. 

Searching for/Generating Batches of CDA Documents/Abstracts 

The eMaRC Plus Physician Reporting module includes a query function that enables you to apply 

user-specified search parameters to dynamically generate a batch of CDA documents, open in them 

CDA Workbench, and review the automated mapping, translation, and consolidation decisions 

made by the program. 

To search for and generate a batch of related CDA documents and open them in the CDA 

Workbench, complete these steps: 
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1. Open the Search Physician Reports window by clicking on the Search  icon on 

the eMaRC Plus main window toolbar. 

Result: The Search Physician Reports window opens, defaulted to the Patient 

Demographics tab. 

 

 

The Search Physician Reports window allows for review of user-specified batches of CDA 

documents along with their translated/mapped NAACCR abstract values using the CDA 

Physician Module Workbench. The Search Physician Reports window consists of a series of 

tabs which display individual search parameters that have been grouped logically on the 

various tabs into Patient Demographics, Provider Information, Diagnostic Information, and 

Case/Transmission/Processing Log Information. Multiple parameters may be specified 

simultaneously both within an individual tab and/or across multiple tabs. “AND” logic is 

applied to the entered search criteria, enabling very specific queries to be generated .   

You can also use the Search window to generate batches of CDA documents for which you 

would like to review individual abstracts along with the consolidated values automatically 

determined by data item-specific consolidation directives (see eMaRC Plus Physician 

Reporting Consolidation Directives).  For the users’ convenience, specific queries can be 

generated and saved, and re-opened and re-run.  

The Search Physician Reports window includes the following search parameters that can be 

used alone or in combination to generate batches of CDA documents and abstracts for review 

on the CDA Workbench. 

Query Results Window 

AND logic used when specifying 

multiple search criteria 

Search Parameter Tabs 

Queries can be saved, 

opened, and edited 

Can review individual abstracts 

along with the consolidated values 

automatically determined by data 

item-specific consolidation directives 



eMaRC Plus Physician Reporting Module   Opening/Searching/Viewing Records 

Version 9.0, Aug 2022  61 

The Patient Demographics Tab 

 

As mentioned, upon opening the Search Physician Reports window, the Patient 

Demographics tab is displayed by default.  The following table describes the search 

parameters available on the Demographics tab: 

Search Parameter Description 

Patient Last Name This option allows the user to specify a particular patient last 

name, which when used in conjunction with the Patient First Name 

option, allows the user to open all CDA documents received for a 

specific patient  

Patient First Name This option allows the user to specify a particular patient first 

name, which when used in conjunction with the Patient Last Name 

option, allows the user to open all  CDA documents received for a 

specific patient 

SSN This option allows the user to enter a specific Social Security 

Number to open all CDA documents received for a specific patient 

Age at Diagnosis or 

Range 

This option allows the user to enter a specific Age at Diagnosis or 

range of ages to open all CDA documents received for patients of 

specific ages (e.g., pediatric cases)  

The Provider Information Tab 
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The next tab allows you to specify search criteria related to the submitting provider. The 

following table describes the search parameters available on the Provider Information tab: 

Search Parameter Description 

Provider NPI This option allows the user to enter a specific Provider NPI 

number to open CDA documents  received from that provider  

Provider Organization 

NPI 

This option allows the user to enter a specific Provider 

Organization NPI number to open CDA documents  received 

from that organization 

Provider Organization 

Name 

This option allows the user to enter a specific Provider 

Organization Name to open CDA documents received from 

that organization 

 

The Diagnostic Information Tab 

 

The Diagnostic Information tab allows you to specify certain types of cancer and/or 

diagnosis dates as search criteria. The following table describes the search parameters 

available on the Diagnostic Information tab: 

Search Parameter Description 

Diagnosis Date Range This option allows the user to enter a date range to open all 

CDA documents by the diagnosis date of the tumors reported 

Primary Site This option allows the user to enter a ICD-O-3 Topography 

code or range of codes  to open CDA documents received 

with the specified primary site(s) 

Histologic Type This option allows the user to enter a ICD-O-3 Histology code 

or range of codes  to open CDA documents received with the 

specified  histology (ies) 
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The Case/Transmission/Processing Log Information Tab 

 

The final grouping of available search criteria are case- and data processing-specific, 

enabling you to review all submitted information from a particular provider facility for a 

specific patient and tumor, or to review batches of CDA documents/abstracts the generated 

the same message to the Processing Log when processed (e.g., CDA documents having 

multiple cancer diagnosis entries that will generate more than one abstract). The following 

table describes the search parameters available on the Case/Transmission/Processing Log 

Information tab: 

Search Parameter Description 

Imported Date Range This option allows the user to enter a date range to open all 

CDA documents by the date the documents were imported 

into eMaRC Plus 

Processing Log Code 

or Range 

This option allows the user to enter a specific Processing Log 

Code  or Codes to open CDA documents that when processed, 

generated the specific Processing Log Code 

PTRID or Range This option allows the user to enter a specific PTRID (or 

range of PTRIDs) to open all CDA documents received for a 

specific patient and tumor from a particular facility 

AbsRefID or Range This option allows the user to open CDA documents 

associated with a specific AbsRefID or Range of AbsRefIDs  

Include Only Un-

exported Consolidated 

Abstracts These options enable the user to examine batches of abstracts 

that have already been exported to the central registry, or 

those yet to be exported Include Only 

Exported 

Consolidated 

Abstracts 
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2. Enter the search parameters of your choice, and click Search.  In the example shown, the 

search parameters being entered will result in the selection of prostate cases reported from 

the facility named Oncology Center. 

 

 

 

Note that as soon as you enter search criteria on any of the tabs, an 

asterisk appears to the left of the tab name.  As the search criteria are 

spread out across separate tabs, this serves as an important a visual cue 

that you have entered a search parameter on that tab, and helps you 

keep track of what parameters you have entered. 

 

 

Result: The CDA documents meeting the search criteria are displayed in the Query Results 

window, where by all records are selected by default.  You can de-select individual documents 

by unchecking the Import ID check box. 
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3. To open the listed CDA documents as a batch for review on the CDA Workbench, click 

Open. 

Result: The CDA Workbench opens with the specified CDA documents and their associated 

auto-generated abstracts displayed in order of ascending AbsRefID. You can now use all of the 

various features of the CDA Workbench to review the batch of related CDA documents. 
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Viewing Abstract Consolidation Results  

4. To review the individual abstracts and the values automatically selected for the consolidated 

abstract, click the View Merged Record Results  icon on the 

Abstract window toolbar.  

Result: The Consolidation Review window opens, with the consolidated abstract and all of the 

individual abstracts listed in columns in an extremely user-friendly fashion that facilitates 

review of the abstract values and the resulting consolidated values chosen by the automated 

consolidation directives. 

 

 

By default the data on the Consolidation Review window are ordered in the same sequence as 

the Abstract Display, and include all data items in the display type, including defaulted and 

hidden data items. Basically this window displays what data items will be exported upon export 

of abstracts from the application. However, the application offers other views to choose from. 

 

You can use the Select View pull-down to specify the view of the data that you would like: 
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View Description 

All NAACCR Layout Selecting this view will display every data item in the 

NAACCR record layout 

Use Display Style This view is the default view and displays only those data 

items included in the Abstract display, in the same order as 

the Abstract Display  

Consolidated data 

items only 

This view will display only those data items that are being 

automatically consolidated by the application 

Use Display Style – 

Remove Confidential 

This option allows the user to open CDA documents 

associated with a specific AbsRefID or Range of AbsRefIDs  

 

5. You can also export the consolidation results to a comma-delimited file that can then be 

opened in Excel.  To export the consolidation results to a .CSV file, click Export. 

Result: The Save As window opens defaulted to the C:\eMaRCPlus\Reports folder. 

 

6. Enter a name for the file, and click Save.  In the example shown, the consolidation review 

report is being saved as OncologyCenterProstate.csv.  

Result: The application asks you whether or not you would like to generate the report 

with confidential patient identifiers, or as a de-identified report.  
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The de-identified report can be shared back to CDC to provide feedback 

on consolidation directives for the non-confidential data items. 

7. Click Yes. 

Result: The application returns you to the Consolidation Review window.  

 

8. Click Close to close the Consolidation window.  

Result: The application returns you to the CDA Workbench.  

9. To close the CDA Workbench, click the X in upper right corner of the window. 

  

Result: The application returns you to the Search Physician Reports window.  
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10. You can save your query and re-open it to re-run or edit at a later time. To save the query, 

click Save Query As. 

Result: The application prompts you to enter a name for the saved query. I the example 

shown the query is being named OncologyCenter_Prostate.  

 

11. Click OK. 

12. To open a saved query, click Open Saved Query. 

 

Result: The Saved Queries window opens and displays a list of all saved queries.  

 



Opening/Searching/Viewing Records               eMaRC Plus Physician Reporting Module  

70  Version 9.0, Aug 2022 

 

At this point you have 4 choices: 

a. You can click Run Query to run the query, which would take to Search Physician 

Reports window with the query results displayed 

b. You can click Open Batch to run the query and go directly to the Consolidation Review 

window. 

c. You can select the query from the list and click Delete to delete the query 

d. Or, you can click Cancel. 

As you can see, via a combination of highly-specific search parameters, you can use the 

Search Physician Reports window to open only the particular CDA documents and 

abstracts that you would like to review. This feature of the program will most likely be 

heavily utilized upon initial setup and verification of the program, to assure the registry 

that the application is working as expected, or to assess what types of cases they may 

want to selectively export out of the application. 

Directly Generating Consolidation Review Report  

You do not have to open the Consolidation Review window in order to export the consolidation 

results to a comma-delimited file; you can do this directly from the Search Physician Reports 

window by clicking Generate Consolidation Review Report. 

 

Result: The Save As window opens defaulted to the C:\eMaRCPlus\Reports folder. 
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13. Enter a name for the file, and click Save.  In the example shown, the consolidation review 

report is being saved as Cooper_Consolidation_Review.csv.  

Result: The application saves the report, and returns you to the Search Physician 

Reports window. 

When you go to open the saved .csv file, it will automatically open in Excel. 
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You format the report in Excel, expanding the column widths and 

aligning the data to make the report more presentable. 

 

 

Note that in the first row of the report, the PTRID is listed for the Consolidated 

Abstract, and the Abstract ID (i.e., AbsRefID) is listed for the individual 

abstracts. 
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Chapter 7: Exporting Abstracts in NAACCR File 
Format 

NOTE: The Export feature is currently being reviewed and will be updated in a future 

release.  

Learning Objectives 

In this chapter, you will learn: 

• About the highly-configurable abstract export features of the Physician Reporting 

Module of eMaRC Plus 

• How to apply user-specified parameters for exporting both initially received abstracts 

and/or subsequently consolidated abstracts in NAACCR Record Layout format 

• How to apply export timing criteria 

• How to save export configurations 

Overview 

This chapter covers the abstract export features of the eMaRC Plus Physician Reporting module. 

You’ll learn how to use the multitude of export options and how to best take advantage of the 

flexibility of the program for use in your registry.  

To export Initially Received and/or Consolidated Abstracts out of the eMaRC Plus Physician 

Reporting module, complete these steps: 

1. Open the Export Physician Abstracts window.  This can be done in 2 ways: 

a. Click on the File menu, and select Export Abstracts. 

 

b. Click on the Export Abstracts   icon on the eMaRC Plus main 

window toolbar. 

Result: The Export Physician Abstracts window opens defaulted to the Abstract 

Export Options tab. 
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The Export Physician Abstracts window allows for the application of user-specified 

parameters for exporting both initially received abstracts and/or subsequently 

consolidated abstracts in NAACCR Record Layout format.  

The Export Physician Abstracts window consists of 2 tabs which display, 

respectively, Abstract Export Options, and Case-Specific Export Parameters. 

Multiple parameters may be specified simultaneously both within an individual tab 

and/or on both tabs. “AND” logic is applied to the entered export criteria, enabling 

very specific exports to be generated.  Export configurations can be generated and 

saved, and re-opened and re-run. Export may also be run automatically using the 

DOS Command Line.  

Export Parameter Tabs 

Export Configurations 

can be saved, opened, 

and edited 
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The Export Physician Abstracts window includes the following export parameters 

that can be used alone or in combination to generate files of NAACCR abstracts to 

export. 

The Abstract Export Options Tab 

 
 

As mentioned, upon opening the Export Physician Abstracts window, the Abstract Export 

Options tab is displayed by default.   

 

There are no export options defaulted on the Export Physician 

Abstracts window.  This is so that registries will need to fully 

understand all the export features and configure their own exports.  

There are many export parameters and it is essential that you 

understand how they work, individually and in conjunction with one 

another. However, once you have setup a specific export configuration 

you can save it, and just open and run it on a regular basis or run it 

automatically from the DOS Command Line. 
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The following table describes the export parameters available on the Abstract Export Options 

tab: 

Abstract Export Parameter Description 

Export All Options  

(These options are mutually 

exclusive; only 1 of these 3 

options can be selected) 

(When using any of the Export 

All options no other export 

options may be applied) 

Export All Abstracts: When selected, this option will 

export both initial and subsequently received abstracts in 

the database regardless of prior export status. Additionally, 

this option will:  

Include records meeting the criteria selected on the Case-

Specific Criteria Tab  

Override any other export option on the Export All Options 

Tab  

NOTE consolidated abstracts are NOT exported when 

using this option 

Export All Initial Abstracts: When selected, this option 

will export all initially received abstracts in the database 

regardless of prior export status. Additionally, this option 

will: 

Include records meeting the criteria selected on the Case-

Specific Criteria Tab  

Override any other export option on the Export All Options 

Tab  

Export All Consolidated Abstracts: When selected, this 

option will export all consolidated abstracts in the database 

regardless of prior export status. Additionally, this option 

will:  

Include records meeting the criteria selected on the Case-

Specific Criteria Tab  

Override any other export option on the Export All Options 

Tab 

Export Initially Reported 

Abstracts? [For RCA or Follow-

back] 

Yes/No option for exporting initially received abstracts (for 

Rapid Case Ascertainment or Follow-back efforts) 

Exclude from Initial Abstracts 

Export 

When the Previously Exported Initial Abstracts option is 

checked along with the Yes option for Export Initially 

Reported Abstracts, all initial abstracts that have not yet 

been exported will be exported, and will prevent re-export 

of previously exported initial abstracts. 
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Abstract Export Parameter Description 

Export Consolidated Abstracts? 

 

Yes/No option for exporting consolidated abstracts; if Yes 

is selected, the user can specify 1 of 3 mutually exclusive 

parameters: 

i. If Yes, XX Days After Initial Report (by PTRID): 

The number of days to wait after the initial Report for 

a PTRID was received; this option would be used 

when the registry would like for CDA documents to be 

received and auto-consolidated and then export the 

consolidated abstract after the specified number of 

days, (e.g., 180 days, the general  length of time for 

treatment to be completed, or you could have multiple 

configurations by primary site for those cancers that 

generally take longer to complete the first course of 

treatment). 

ii. If Yes, XX Days After Last Report (by PTRID): 

The number of days to wait after the last Report was 

received for a PTRID; this option would be used when 

the registry would like to export consolidated abstracts 

after it appears that no more CDA documents are 

being submitted for a PTRID (e.g., ~90 or 120 days), 

enabling the registry to export the consolidated record 

only once.  

iii. If Yes, XX Days After Last Export: The number of 

days to wait after the last export was performed for a 

PTRID; this option could be used when the registry 

would like to perform one final export to capture any 

potentially additional treatment and to update Date of 

Last Contact. (e.g., 365 days) 

Exclude from Consolidated 

Abstracts Export 

When the Previously Exported Consolidated Abstracts 

option is checked along with the any of the 3 Yes options 

selected for Consolidated Abstracts, all consolidated 

abstracts that have not yet been exported will be exported, 

preventing re-export of previously exported consolidated 

abstracts. 

Mark Exported Abstracts as 

Exported/Unexported 

When the Mark as Exported option is selected, all exported 

abstracts will be marked as exported--this prevents 

duplicate export of abstracts. When the Mark as 

Unexported option is selected, exported abstracts will not 

be marked as exported. 
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The Case-specific Export Parameters Tab 

 

 
 

As mentioned, upon opening the Export Physician Abstracts window, the Abstract Export 

Options is displayed by default, where you specify global export options, such as whether 

you want to export initially received abstracts or consolidated abstracts as well as timing 

criteria. In addition, highly specific export criteria are available on the second tab, the Case-

Specific Export Parameters tab.  
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The following table describes the export parameters available on the Case-Specific Export 

Parameters tab: 

Case-Specific Export 
Parameter 

Description 

Patient Demographics Last Name: This option allows the user to specify a 

particular patient last name, which when used in 

conjunction with the Patient First Name option, allows the 

user to export abstracts for a specific patient 

First Name This option allows the user to specify a 

particular patient first name, which when used in 

conjunction with the Last Name option, allows the user to 

export abstracts for a specific patient 

SSN: This option allows the user to enter a specific Social 

Security Number to export abstracts for a specific patient 

Age at Diagnosis or Range: This option allows the user to 

enter a specific Age at Diagnosis or range of ages to export 

abstracts for patients of specific ages (e.g., pediatric cases) 

Diagnostic Information Diagnosis Date: This option allows the user to enter a date 

range to export abstracts by the diagnosis date of the 

tumors reported in the abstracts 

Primary Site: This option allows the user to enter a ICD-

O-3 Topography code or range of codes to export abstracts 

having the specified primary site(s) 

Histologic Type: This option allows the user to enter a 

ICD-O-3 Histology code or range of codes to export 

abstracts having the specified histology (ies) 

Provider Information Provider NPI: This option allows the user to enter a 

specific Provider NPI number to export abstracts received 

from that provider  

Provider Organization NPI: This option allows the user 

to enter a specific Provider Organization NPI number to 

export abstracts received from that organization 

Provider Organization Name: This option allows the user 

to enter a specific Provider Organization Name to export 

abstracts received from that organization 
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Case-Specific Export 
Parameter 

Description 

Case/Transmission Information Imported Date Range: This option allows the user to 

enter a date range to export abstracts by the dates that they 

were imported into eMaRC Plus 

Abstract Reference ID or Range: This option allows the 

user to enter a specific AbsRefID or range of AbsRefIDs to 

export specific abstracts 

 

 

Note that as soon as you enter export criteria on the Case-Specific Export 

Parameter tab, an asterisk appears to the left of the tab name: 

  

As the export criteria are spread out across separate tabs, this serves as an 

important a visual cue that you have entered an export parameter on that 

tab, and helps you keep track of what parameters you have entered. 

In addition, whenever you do specify export criteria on the Case-Specific 

Export Parameter tab, the application will prompt you to confirm that you 

do indeed want to use these export criteria: 

 

 

2. Specify all of your export parameters, and then click Export. 

Result: As stated above, if you have specified export criteria on the Case-Specific Export 

Parameter tab, the application will prompt you to confirm that you do indeed want to use 

these export criteria. 

 

3. Click Yes. 

Result:  The Browse for Folder window opens, defaulted to the C:\eMaRCPlus\Exports 

folder.  You may navigate to a different location on your computer or network. 
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4. Click OK. 

Result: The application lets you know how many abstracts were exported to the specified 

folder 

 

Export File Naming Options 

Regardless of any of the Specific Export Options selected (excluding the Export All Options) all 

abstracts exported out of the eMaRC Plus Physician Reporting module are in the NAACCR 

Record Type A format. Users utilize the File Save Option to select whether to generate a single 

export file or individual files of abstracts: 

• Prompt for Filename: When selected the user is prompted to enter a specific filename 

for a single generated single file of exported abstracts. 

• Use Reporting Facility Auto-naming Feature: When selected eMaRC Plus generates 

individual files by Reporting Facility and automatically names the files using the naming 

convention of ep_xxxxxxxxxx_yy.dat, where the “ep_” prefix indicates an export out of 

eMaRC Plus, the x’s represent the Reporting Facility ID [#540], and the y’s represent a 

sequential number assigned to each file of abstracts exported for that facility (e.g., 

ep_1111111111_11.dat). A file of exported abstracts will be generated for each facility. 

 

The PTRID will be exported with each abstract, enabling the central registry to 

link back to the eMaRC Plus CDA database for any patient or group of patients. 

The PTRID will be 10 characters in length and located in positions 20911 to 

20920 in the NAACCR Record Layout in abstracts exported out of the eMaRC 

Plus Physician Reporting module. 
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Saving Export Configurations 

As mentioned earlier, once you have setup specific export configurations, eMaRC Plus allows 

you to save your export configurations so that all you have to do is open and run the export on a 

regular basis or run it automatically from the DOS Command Line. 

 

To save an export configuration, complete these steps: 

1. Open the Export Save As window. This can be done in 2 ways: 

a. On the Export Physician Abstract window, click on the File menu, and select Save 

Export Configuration… 

 

b. Click on the Save Export Configuration As   icon on the Export 

Physician Abstracts window toolbar. 

Result: The Export Save As window opens defaulted to the C:\eMaRCPlus\Exports 

folder. 

 

2. Enter a name for the export configuration file and click Save.  Export configuration files are 

stored in XML format.  Be sure to give the name of the configuration a meaningful name, so 

that you will be able to know exactly what it exports when you open it at a later time. In the 

example shown, the export configuration file is being saved as 

Cooper_Consolidation_Review.xml.  
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Result: The application saves the export configuration file and returns you to the 

Export Physician Abstracts window. 

 

You can automatically run saved export configurations using the DOS Command 

Line. 

Opening Saved Export Configurations 

As mentioned earlier, once you have setup specific export configurations, eMaRC Plus allows 

you to save your export configurations so that all you have to do is open and run the export on a 

regular basis or run it automatically from the DOS Command Line. To open a saved export 

configuration, complete these steps: 

1. Open the Open Export window. This can be done in 2 ways: 

a. On the Export Physician Abstract window, click on the File menu, and select Open 

Export Configuration… 

 

b. Click on the Open Export Configuration File   icon on the 

Export Physician Abstracts window toolbar. 

Result: The Open Export window opens defaulted to the C:\eMaRCPlus\Exports 

folder. 
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2. Select the export configuration file you would like to open and click Open. In the example 

shown, the export configuration file being opened is Cooper_Consolidation_Review.xml.  

Result: The application opens the selected export configuration file on the Export 

Physician Abstracts window. 

 

 

3. To run the export, click Export. 

Export Files 

The eMaRC Plus Physician Reporting module includes an electronic export file, so that you can 

track your exports. The files are located in C:\eMaRCPlus. 
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The export window includes “tool tips”, which gives you a brief description of the Export All 

Options and the File Save Option. Simply hover your cursor over each function to display tool 

tips. This feature will include additional export options in a future release. 
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Chapter 8: Automatically Exporting Using DOS 
Command 

Learning Objectives 

In this chapter, you will learn to: 

• Use the DOS Command Line to automatically export batches of abstracts out of the 

eMaRC Plus the Physician Reporting module 

Overview 

This chapter covers instructions regarding running commands from the DOS prompt to export 

batches of abstracts.  These exports can be scheduled so that they run automatically at a specified 

time.  In addition, the commands include specification of which saved export configuration to 

use, so you can run multiple export configurations in this manner.  

Running Physician Abstract Exports from the DOS Command Line  

To enable automation of the export process, the DOS command line interface can be used to 

automatically export abstracts using a saved export configuration file and export location. You 

also have the option of naming the export file, or letting the application use the auto-naming 

feature. 

To use the DOS command line prompt to export physician abstracts, complete these steps: 

3. Open the DOS command prompt window. 

a. On Windows XP:  

i. Click on Start then select Run. 

ii. Type cmd in Open box and press Enter. 

b. On Windows Vista/ Windows 7/ Windows 8.0/Windows server:  

i. Type cmd in the Start---> Run box. 

ii. Press the keystrokes Ctrl+Shift+Enter (this will open the command prompt 

in Administrator mode). 

4. At the command prompt, type cd\ and press Enter to go to the root directory (i.e., C:\) 

5. Type CD C:\eMaRCPlusand press Enter. 

6. Enter the following command at the prompt:  

eMaRCPlus.exe action=export folder=<folder to export file to> File=<File to 

export file to> config=<filename and location of export configuration file> 

user=<eMaRC Plus userid> pwd=<eMaRC Plus user password> 

See Saving Export Configurations to learn how to save the export configuration that is 

specified in the above DOS Command. 
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When the File= parameter is not specified, the export filenames will be 

auto-generated based on the Report Facility ID [#540]. 

Example 1: Exporting and specifying a file name for the export file 

(MyExport.dat) 

eMaRCPlus.exe action=export folder=C:\eMaRCPlus\Exports File=MyExport.dat 

config=C:\eMaRCPlus\export.xml user=doe pwd=guest 

Example 2: Exporting and letting eMaRC Plus auto-generate the exported file 

name 

eMaRCPlus.exe action=export folder=C:\eMaRCPlus\Exports 

config=C:\eMaRCPlus\export.xml user=doe pwd=guest 
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Chapter 9: Various Application Use Scenarios 

Learning Objectives 

In this chapter, you will: 

• Familiarize yourself with the different ways the Physician Reporting Module can be used 

by central cancer registries 

Overview 

It is well-known that certain cancers, such as prostate and melanoma of the skin, are under-

reported to state central cancer registries due to the fact that hospitals and pathology laboratories 

serve as the main source of cancer reports for the majority of registries, and many of these 

tumors are diagnosed and treated in physician offices and other outpatient settings.  As a result, 

the implementation of physician reporting via the eMaRC Plus Physician Reporting module has 

the potential to increase case completeness for these under-reported tumors, enabling the registry 

to generate more accurate incidence rates and provide more complete data to researchers.  

However, implementing a new source of cancer reporting with no increase in registry resources 

or staffing to address the processing of the resulting additional caseload can be quite daunting for 

a central registry. However, registries may choose one of many different approaches to integrate 

the Physician Reporting Module of eMaRC Plus into their registry operations to facilitate the 

implementation of Physician Reporting from the EHR, The approach taken by the registry will 

depend largely on the following factors: 

• Staff time and available computing resources 

• Accuracy of incoming data 

• The registry’s percent case completeness and need to increase it overall and/or for 

various primary sites 

• The registry’s percent of cases identified by Death Certificate Only (DCOs) 

• How many physicians are reporting to the registry from the EHR (% of overall caseload) 

As a result, central cancer registries can make registry operations decisions regarding how they 

use the eMaRC Plus Physician Reporting module and the supplementary data that it can 

potentially provide to the registry: 

Rapid Case Ascertainment (RCA) 

Central registries that perform RCA will want to export all initially-received cancer abstracts 

immediately for import into central database, and then perform a subsequent export of the 

consolidated abstracts once the first course of treatment has been completed.  

The export options that are selected below (Export Initially Reported Abstracts; Exclude 

Previously Exported Initial Abstracts and Export Consolidated Abstracts 180 Days after Initial 

Report; Exclude Previously exported Consolidated Abstracts, as well as Mark Exported 

Abstracts as Exported) would allow a registry that performs RCA to export all un-exported 
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abstracts to-date (both RCA cases and more complete consolidated reports) automatically, and 

will prevent re-export of previously exported abstracts, thus preventing reporting of unwanted 

duplicate abstracts to the central registry. Recall that the initially reported abstract is assigned a 

special “Initial Report” status code and is stored in both the Facility Abstracts Table and the 

Consolidated Abstracts Table (serving as the base abstract for consolidation). 

 

 

Regular Reporting 

Some registries will want to set up eMaRC Plus Physician reporting to mimic a regular reporting 

scenario, such as from a hospital, waiting until the first course of treatment is complete, and 

export a single consolidated abstract for import into central database. 

The export options that are selected below (Export Consolidated Abstracts 180 Days after Initial 

Report; Exclude Previously exported Consolidated Abstracts, as well as Mark Exported 

Abstracts as Exported) would allow a registry to export all un-exported consolidated abstracts 

with first course of treatment complete (estimated at 180 days) to-date automatically, and will 

prevent re-export of previously exported abstracts, thus preventing reporting of unwanted 

duplicate abstracts to the central registry.  
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Regular Reporting for Under-reported Cancers Only 

Some registries will not have the resources to process all physician reports received from the 

EHR. These registries may choose to set up eMaRC Plus Physician reporting to mimic a regular 

reporting scenario, such as from a hospital, waiting until the first course of treatment is complete, 

and export a single consolidated abstract for import into central database, but only for specific 

types of cancer that they know are under-reported to their registry, such as melanoma, prostate, 

and leukemia. 

In this case, the export options that are selected above for regular reporting would be the same, 

only supplemented with additional Case-Specific Export Parameters: 
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In the example shown, only melanomas of the skin would be exported with estimated first course 

of treatment completed within 180 days.  One of the excellent features of the program is that you 

can specify differing numbers of Days After Initial Import for different types of cancers.  Some 

types of cancers are known to have a first course of treatment longer than 180 days, and so a 

separate export configuration could be specified for the type of cancer with a greater number of 

Days After Initial Report.  

Casefinding Only 

Some may just conduct an annual linkage of their central registry database with an extract of all 

consolidated cases from the Physician Reporting module to be able to process only those cases 

for which they have no other report (i.e., use the Physician module as a case-finding tool). 

These registries would want to utilize the Export All options if, for example, the registry would 

like to generate an extract and perform a linkage with their entire central registry database, they 

may choose to export all consolidated abstracts.   

 

If desired, additional Case-Specific Export parameters could be used to restrict the file being 

exported for linkage to certain types of cancers, or diagnosis dates. 

Reducing Percent Death Certificate Only (DCO) Cases 

Some registries may want to just use the application to reduce the percent of DCOs.  These 

registries would want to utilize the Export All Consolidated option, and perform a linkage with a 

file including the DCO cases on their database.  
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These are just a few examples of how the highly configurable export features of 

the eMaRC Plus Physician Reporting module can be utilized to address the 

diverse needs of, and resources available to process this new reporting source by, 

central cancer registries. 
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Chapter 10: Physician Module Administrative Features 

Learning Objectives 

In this chapter, you will learn about the Administrative features of the eMaRC Plus Physician 

Reporting Module, including: 

• Managing the Abstract Display Type 

• Managing the CDA document display 

• Specifying system configuration settings 

• Deleting CDA documents 

Overview 

This chapter covers the features available under the Administration menu item, including 

managing the Abstract Display, the Document display, and system configuration options.  

Managing the Abstract Display  

A “display type” is a feature common to the majority of Registry Plus applications, and is 

basically the user interface where cancer data are abstracted and viewed, or in the case of the 

Physician Reporting Module, automatically populated and viewed on the CDA Workbench.  

Display types are highly customizable, and delineate what data items are collected/required, etc. 

Any standard data items and state-specific fields can be included in a display type, can be 

logically ordered into sections to facilitate the viewing of the data, and have various properties 

that can be set such as default values.   

The default Abstract Display that is included with the application is set up to accommodate all of 

the mapped and translated CDA data elements, and includes defaults for those NAACCR data 

items that are required, but not available with the CDA document. However, states may want to 

revise the default Abstract Display, in particular the suggested default values for those NAACCR 

data items that are required but not available within the CDA document. They may also want to 

add state-specific data items to the application/Display, re-order fields in the Display, re-label 

sections, etc. 

To manage the Abstract Display, complete these steps: 

1. Open the SelectAbstractFieldsCDA window.  Click on the File menu, and select Manage 

Abstract Display… 
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Result: The SelectAbstractFieldsCDA window opens. 

 

You can select the fields for which data is to be defaulted, mapped or translated into or out of 

the display type, and group the fields into sections if desired. Using the left and right arrow 

buttons, fields and section headings are moved from the lists of available data fields and 

section headings on the left side of the window to the list of data fields and section headings 

on the right to include them in the selected display type.  The Sequence up and down arrow 

buttons are used to re-order the fields and section headings once they have been added to the 

display type. 

Adding Section Headings to a Display Type 

Section headings are added to a display type to organize the fields in the display type into logical 

groups of related fields. 

To add an existing section heading to a display type, complete these steps: 

1. In the Selected fields for abstract display list, select the field above which you would like to 

place the Section header.  In the example shown, the section heading of DATA TO BE 

CODED is being moved into the display type above the field of Histologic Type ICD-O-3, so 

the field of Histologic Type ICD-O-3 is selected from the Selected fields for abstract display 

list. 

Move Section 

Headings 

into/out of 

Display Type  

Available 

Fields and 

Section 

Headings 

Re-order 

Fields and 

Headings  

Set 

Individual 

Field 

Properties 

Fields 

Assigned 

to Display 

Type  

Move Fields 

into/out of 

Display Type  
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2. In the Section Headers list on the lower left pane of the window, select the section heading 

that you would like to move into the display type.  In the example shown, the section heading 

of DATA TO BE CODED is selected. 

3. Click the right-pointing arrow  to move the heading into the display type. 

Result: The section heading is removed from the Section Headings for Display Type list on 

the left, and is moved into the Selected fields for abstract display list on the right, above the 

currently-selected field in the list. 
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Adding a New Section Heading 

To add a new section heading to the application, complete these steps: 

1. Below the In the Section Headers list on the lower left pane of the window, click Add 

Section.  

Result:  The Add Section window opens. 

 

2. Enter a name for the new section header and click OK.  In the example shown, a section 

header named NEW SECTION is being added. 

Result:  The new section is added to the list of existing section headings. 
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Deleting a Section Heading 

To delete a section heading, complete these steps: 

1. Select the section heading that you would like to delete from the List Section Headers on 

the left, and click Delete.  In the example shown, the section heading being deleted is named 

NEW SECTION, so it is selected from the List of Available Section Headings. 

   

Result:  The application prompts you to confirm that you would like to delete the currently 

selected section heading. 

 

2. Click Yes. 

Result:  The section heading is deleted from the application, and is no longer listed in the 

List of Section Headers. 

Adding Fields to a Display Type 

After adding section headings to the Selected fields for abstract display list, you then add fields 

to the display type.  When adding fields to a display type it is important to keep in mind which 

data items you would like to collect, and of those data items, which you would like to require 

(i.e., make a critical field, cannot be blank), as well as which data items you would like to fill 

with a default value. It is also important to know which data items your central registry system 

will require when the abstracts exported out of eMaRC Plus are imported into your central 

registry system, for example, system fields such as Morph Coding Sys-Current.  
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To add fields to a display type, complete these steps:  

1. In the Selected fields for abstract display list, select the field or section heading below 

which you would like to place the field that you are adding to the display type.  In the 

example shown, the Addr at DX Country [#102] field is being added to the display type 

below the field of Addr at DX—Postal Code [#100], so the field of Addr at DX—Postal 

Code is selected from the Selected fields for abstract display list. 

 

2. In the Available NAACCR Type A Fields list on the left, select the field or fields that you 

would like to move into the display type. In the example shown, the Addr at DX Country 

field is being added to the display type. 

 

To select one field, click the name of the field.  To select a group of 

fields together, click the first field, press and hold the SHIFT key, 

and then click the last field in the group.  To select multiple fields 

that are not in order, press and hold the CTRL key and click each 

field. 

3. Click the right-pointing arrow  to move the field or fields into the display type. 

Result: The field(s) is removed from the Available NAACCR Type A Fields on the left, and 

is moved into the Selected fields for abstract display list on the right, below the currently-

selected field in the list. 
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4. If the order of the placed fields is not as desired, use the SEQUENCE up  and down 

 arrows to move the field or fields up or down in the order of the display type to the 

desired position. 

5. Save updates to the display type by clicking Save. 

Assigning Property Values to Individual Fields 

Once a field has been added to a display type, special properties may be specified for the field, 

such as a default value. 

To assign property values to a field, complete these steps: 

1. In the Selected fields for abstract display list, locate and select the data item for which 

you would like to specify field properties. In the example shown, properties are being 

reviewed for the field of NAACCR Record Version. 
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2. Click Properties. 

Result:  The Properties window opens for the selected field. 

  

These are the fields in the Properties window: 

Property Description 

Fore Color Adjusts the font color of the field 

Back Color Adjusts the background color of the field 

Field Default Value Value that is initially displayed in the field 

Protected When check box is checked, value of field is displayed 

to the Abstractor, but cannot be edited 
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Property Description 

Invisible When check box is checked, the field is not visible to 

the user, but a defaulted value is edited and transmitted 

with the abstract 

Required When check box is checked, the field is considered a 

“Required Field”, i.e., cannot be blank; the abstract 

will not be marked as Complete if this field is blank 

In the example shown, the field of NAACCR Record Version has been set to invisible and 

defaulted to a value of 140. 

3. Click Cancel. 

Result:  You are returned to the SelectAbstractFieldsCDA window. 

 

Now take notice of the symbols to the right of the NAACCR Record Version field name.  

These symbols represent the properties assigned to the field. 

Field property definitions are displayed to the right of the field name and NAACCR Data 

Item Number in parentheses in the Selected fields for abstract display list.  In addition, they 

are separated with commas and are always listed in the same order, as defined in the 

following table: 

Property Symbol Description 

p Protected – value cannot be changed by the user 
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Property Symbol Description 

i 
Invisible – value cannot be seen by the user in the 

display type  

d = 

Default Value Follows equal sign – value that will 

automatically be populated in this field in the display 

type 

The following table illustrates some examples of set properties and the symbols that are 

displayed for the set properties in the Selected fields for abstract display list: 

Property Setting Description 

Record Type (10) =A 

The field of Record Type, NAACCR item #10, 

will be defaulted to a value of A; the field may  

be modified by the user 

Record Type (10) i, d = A, 

The field of Record Type, NAACCR item #10 

is set to invisible, and defaulted to a value of A; 

the field cannot be modified by the user because 

it will not be visible in the display type 

Record Type (10) p, i, d = A 

The field of Record Type, NAACCR item #10 

is set to protected, invisible, and assigned a 

default value of A 

System Fields and Display Types 

A final consideration when generating abstracting display types is the inclusion of and provision 

of default values to any system- or coding system-related fields that your central registry system 

may require when the completed abstract is eventually submitted for processing at your central 

registry.  The below table contains a list of NAACCR data items, along with their suggested 

default values, that are recommended for inclusion in display types.  If you do not want the user 

to see these fields or their values, you can assign default values to the fields, and then set the 

fields to protected and invisible.  In this way, the fields will be transmitted with the exported 

abstract, but the user will not have to abstract or even be aware of the fields.  

NAACCR Data Item Name 
Data 
Item # 

Column # 
Suggested 
Default Value 

Record Type  10 001   A 

NAACCR Record Version  50 017   150 

Race Coding Sys-Current  170 187   7 

Race Coding Sys-Original  180 188   7 

Site Coding Sys-Current  450 558 5 

Site Coding Sys-Original  460 559   5 
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NAACCR Data Item Name 
Data 
Item # 

Column # 
Suggested 
Default Value 

Morph Coding Sys-Current  470 560   8 

Morph Coding Sys-Original  480 561   8 

RX Coding System-Current  1460 1593 06 

SEER Coding Sys-Current  2120 1930  E 

SEER Coding Sys-Original  2130 1931  E 

COC Coding Sys-Current  2140 1932  08 

COC Coding Sys-Original  2150 1934 08 

ICD-O-3 Conversion Flag  2116 2015  0 

 

 

See Appendix B for the Display Type Report for the Abstract Display 

included in the eMaRC Plus Physician Reporting module.  This report 

lists all the fields that have been included in the display type as well as 

any field properties that have been set, including default values. 

Managing the Document Display 

The CDA Document Display is managed in a similar manner as that of the Abstract 

Display. There are separate document displays for MU2 and MU3 documents, as they have 

some data elements that are not the same. 

To manage the Document Display, complete these steps:Open the Document Display window.  

Click on the File menu, select Manage Document Display, and select Meaningful Use 2 or 

Meaningful Use 3… 

 

Result: The Document Display window for the selected MU version opens. 
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The CDA Document data elements can be moved into and out of the Document display, 

and can be logically ordered into sections to facilitate the viewing of the data.  However, 

the Document Display is not as flexible as that Abstract Display.  No field properties can 

be set for the data elements, and the user is limited in the data elements that can be 

transferred into and out of the Display as well as re-ordered.  The Document Display 

window will be made more functional in a future release of the program. 
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Manage Facility 

Mapping of NPI/Facility Name to Local Facility ID 

Manage facility allows the option to have the NPI and/or facility name provided in the 

CDA document mapped to your state specific local ID. This includes the ability to 

associate multiple NPI numbers with a single facility. 

To manage facility settings, complete these steps: 

1. Open the Manage Facility window.  Click on the Administration menu, and select Manage 

Facility… 

 

Result: The Manage Facility window opens 
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Manage Facility will be used if the state assigns a local ID (FIN) to facilities. 

Steps to Find, Add, Update, Add NPI Numbers, and Delete within Manage facility: 

 

To find a facility, enter a portion of the facility name in the Search Facility field and click the 

Find button. All facilities with the search text are displayed in the list pane. 

 

To Add a new facility: 

 

Enter the new Facility’s ID in the Facility ID field. 

Enter the new Facility’s Name in the Facility Name field. 

Enter the new Facility’s NPI number in the NPI field. (Note: In the CDA document, the 

Custodian NPI will be mapped) 

Click the Add button. 

 

To Edit an existing facility: 

 

Select it in the list and edit the ID or NPI number as required and click the Update button. 

 

To add multiple NPIs to a single facility ID: 

 

Enter the Facility Name in the Facility Name filed. 

Enter the Facility ID in the Facility ID field. 

Enter the NPI number in the NPI Number field. 

Click the Add button. 

 

To Remove a facility from eMaRC Plus: 

 

Select the Facility in the list pane and click the Delete button. 

When all Facilities have been added and edited as desired, click the Close button. 

 

Directly Provided Local Facility ID (New Feature!) 

 
eMaRC also enables direct mapping of the state’s local facility ID if provided when it is 

provided in the CDA document. States will need to give your state-specific Object Identifier 

(OID) to each provider with an EHR capable of implementing this feature. See Appendix C for 

table of state-specific OIDs.  

 
You will also need to configure eMaRC to recognize this OID. Please following the instructions 

you see the first time you open eMaRC after the update/install: 
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Managing System Configuration Settings 

Prior to using the Physician Reporting module of eMaRC Plus you must first configure the 

application for use, including specifying database connection strings and other various database 

options, configuring import from PHINMS or a specified folder, and entering the formal name of  

your central registry for use on reports. 

To manage system configuration settings, complete these steps: 

2. Using the Login window.  Click on System Configuration… 

 

Result: The System Administrators Login window will appear. 

 

3. An administrator will login with a user name and password… 
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Result: The System Configuration window will appear. 

 

System configuration has three tabs; Database Setting, PHINMS Setting, and Notification 

Setting. 

System Configuration Tab Description 

Database Setting 
Tab is used to specify database options for 

eMaRC Plus. 

PHINMS Setting PHINMS configuration options. 

Notification Setting File import notification settings.   



eMaRC Plus Physician Reporting Module   Physician Module Administrative Features 

Version 9.0, Aug 2022  109 

 

Basically, you will be setting the application up to either look to PHINMS (i.e., use the Poll 

and Import Physician Reports from PHINMS Queue option) when checking for CDA 

documents to import or to look to a specified folder (i.e., use the Poll and Import Physician 

Reports from Folder option) when checking for CDA documents to import. 

 

 

 

 

 

The following table describes the configuration fields available on the Configuration 

window: 

Field Description 

Select Database Type Use this option to specify the database type; Although the 

Physician Reporting module of eMaRC Plus comes defaulted 

to the Microsoft Access database type, when moved into a 

production environment, you will need to set the application 

database to SQL Server 

Physician Reports 

Database 

Enter the connection string to the eMaRC Plus pathlab.mdb 

Access database/SQLserver database 

PHIN Worker Queue 

Connection String 

Enter the connection string to the eMaRC Plus pathlab.mdb 

Access database/SQLserver database where the 

PHINWorkerQueue table resides 

Worker Queue Name WorkerQueueName is the table in the database that PHINMS 

fills with new CDA documents; can be same table as used for 

the ePath module or not; depends on how  your registry sets 

up the database (defaulted to testworkerqueue in the 

pathlab.mdb Access database); If the application is set up to 

look to a specified folder for importing new CDA documents, 

this table will only store the actual name of the CDA 

document file (the file itself will be physically placed into the 

folder specified in the PHINMS Receive Folder Path field) 

Read File from 

PHINMS Queue 

Specifies whether the application is to look to PHINMS to 

poll for new reports or to a specified folder; this option is 

checked by default, if you would like to setup the application 

to check a specified folder from which to import CDA 

Documents you will need to un-check this check box 
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Field Description 

PHINMS Receive 

Folder Path 

If the Read file from PHINMS Queue option is un-checked 

(indicating you would like the application to check a specified 

folder from which to import CDA documents), this option 

becomes active and then the path to the specified folder is 

entered into this field  

Service code If the same WorkerQueueName table is specified for both 

ePath and the Physician Reporting module, the service code 

specifies which type of file to poll for and import (e.g.., HL7 

[ePath] or CDA [physician report]); Services codes are state-

specific and are specified by the state upon set up of PHINMS 

Archive Folder If the Read file from PHINMS Queue option is un-checked 

(indicating you would like the application to check a specified 

folder from which to import CDA documents rather than 

PHINMS), this option specifies the archive folder to which 

the imported CDA documents will be moved to after import  

If the application is set up to look to PHINMS, upon import 

CDA documents physically are stored as a “blob” in the 

WorkerQueueTable, however, if the application is set up to 

read from a specified folder then the WorkerQueueTable will 

only store the actual name of the CDA document 

Registry Name for 

Report Titles 

Enter the formal name of your central registry as you would 

like it to appear on the reports generated by the Physician 

Reporting Module 

4. For troubleshooting purposes, you can select Test Connection on the Physician Reports 

Database Connection String, which will provide feedback to determine if the connection was 

successful or if it failed. 

5. Specify your system configuration settings and click Save. 

Result: The Saving System Configuration window opens and notifies the user that the 

system configuration settings have been saved and that the application must be restarted for 

the settings to take effect. 
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Deleting Imported CDA Documents 

To delete CDA documents that have been imported, complete these steps: 

1. Open the Document Display window.  Click on the File menu, and select Manage Import 

Documents… 

 

Result: The Manage Import Documents window opens. 

 

 

 

You will need to close any other windows you may have opened in the 

application prior to opening the Manage Import Documents window.  If 

you forget, the application will prompt you to do so: 

 

2. To delete one or more files, select one or more files from the list of displayed CDA 

documents and click Delete Selected Files. 

3. Click Refresh, and the deleted files will no longer be listed. 

4. To close the Manage Import Documents dialog box, click Close.  
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The Manage Import Documents window doesn’t really serve any purpose other than for 

testing the features of the program, because eMaRC Plus will only let you import the 

same CDA Document only once. As a result, if you want to re-load a CDA document, 

you need to delete it from the application first. 

 

If you delete a single CDA document that is the only document 

that has been submitted for a particular PTRID, and therefore only 

has a consolidated abstract based on a single CDA 

document/abstract, all entries will be deleted from the database.  

However, if more than one CDA document was received for a 

PTRID, and only one of those documents is deleted, the specified 

CDA document will be deleted, but consolidation process will not 

re-run (to be addressed in a future version). 



eMaRC Plus Physician Reporting Module   Running and Viewing Reports 

Version 9.0, Aug 2022  113 

Chapter 11: Running and Viewing Reports  

Learning Objectives 

In this chapter, you will learn to: 

• Identify the different reports you can run within the eMaRC Plus Physician Reporting 

module  

• Open an eMaRC Plus Physician Reporting module report, and use the various Report 

Viewer window options to maximize your report viewing experience 

• Become familiar with the all of the different file formats in which reports can be saved 

Overview 

This chapter covers general information about eMaRC Plus Physician Reporting module reports.  

It includes a description of all reports offered by the application, how to open the reports, how to 

use the Report Viewer window, and how to print and save reports. 

Available Reports 

The monitoring of the physician reporting data submission process are supported in the eMaRC 

Plus Physician Reporting module by a few standard, easy-to-understand reports that can help 

facilitate the tracking of submissions. In addition, the Display Type Report helps with 

management and documentation of the Abstract Display in the Physician Reporting module. The 

reports included can be opened upon request using the Reports icon on the main eMaRC Plus 

window toolbar. The available reports are described in the table below. 

Report Description 

Total Number of 

Physician Reports 

Received by Provider  

Lists the overall total number of CDA documents received 

by submitting Provider during the user-specified date range 

Number of Physician 

Reports Received by 

Provider and PTRID 

Lists the total number of CDA documents received by 

submitting Provider and PTRID during the user-specified 

date range 

Display Type Report 
Line listing report which includes abstracts based on user-

specified criteria 

Opening Reports 

To open any of the reports, complete these steps: 

1. Click on the Reports icon  on the toolbar. 

Result: The Reports window opens. 
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2. Select the report you would like to view and click Run Report. In the example shown, the 

Total Number of CDA Messages Received by Provider report is being selected. 

Result: If the report requires entry of a user-specified date range, the Date Range window 

opens. 

 

You can choose to enter a range of dates by Date Case Received or Diagnosis Date. 

3. Enter the desired date range for the date field of your choice and Click OK. In the example 

shown the date range of 2014/06/01 to 2014/06/11 is being entered for the Date Case 

Received. 

Result: The report of interest opens in the eMaRC Plus Report Viewer window. 
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Viewing Reports – The Report Viewer Window 

 

The Report Viewer window is divided into 2 main sections: a window in which to view reports 

on the left, and a pane for viewing report thumbnails on the right.  When you left-click and hold 

your mouse on the vertical divider bar in the center of the window, a splitter appears which you 

can drag to the left or right to resize the view report and thumbnails views.   

The Main Toolbar 

 

The Report Viewer Main Toolbar includes icons to print and save the report being viewed, as 

well as modify the current view of the report.  The following table describes the function of each 

of the icons on the Main Toolbar, as well as listing keystroke equivalents where available for 

each function. 

Icon Keystroke Function 

 Ctrl+P 
Print the report being viewed; opens the print dialog 

window 

Page 

Navigation 

Controls 

Can 

Resize 

Panes 

Main 

Toolbar 

Page View 

Controls 

Report 

Being 

Run 

Report 

Thumbnails 

Open 

Search 

Toolbar 
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Icon Keystroke Function 

 Ctrl+O Save the report being viewed to various file formats 

 Ctrl+Shift+S Change report page setup: size, orientation and margins 

 Ctrl+B 

Show/hide the tree of bookmarks of the report being 

viewed; bookmarks are displayed by default---if there are 

no bookmarks in the report the Report Viewer will 

automatically hide the tree of bookmarks 

 Ctrl+T 
Show/hide the thumbnail view of reports in the pane on the 

right 

 Ctrl+F Search; Open the Search Toolbar 

 F2 View the report in full screen mode 

 F3 View the report one page at-a-time 

 F5 
Control page width; when clicked report will enlarge to the 

page width of Report Viewer window 

 No keystroke Close a report  

Page Navigation Controls 

 

Report page navigation controls are located in the lower left-hand corner of the Report Viewer 

window and help you navigate through the various pages of the report being viewed. The 

following table describes the function of each of the page navigation controls. 

Control Function 

 
View the first page of the report being viewed 

 
View the previous page of the report being viewed 

 Lists the page number of the current page of the report being viewed 

 
View the next page of the report being viewed 
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Control Function 

 
View the last page of the report being viewed 

The Search Toolbar 

The search panel is used to search for specific text within the report.  To access feature, click the 

binocular icon  on the main toolbar. 

 

When opened, the Search Toolbar is located in the lower left -hand corner of the Report Viewer 

window directly over the Page Navigation controls. The following table describes the function of 

each of the Search toolbar icons. 

Icon Function 

 Closes the Search Toolbar 

 
Enter the term being searched for in the Find What box 

 
When clicked, searches the report and finds the next 

occurrence of the search term entered in the Find What box 

 
When checked, the search is repeated with case of the search 

term considered 

 
When checked, the search is repeated with only whole words 

of the search term considered 

Page View Controls 

 

Report page view controls are located in the lower right-hand corner of the Report Viewer 

window, and include icons to help you control how many pages of the report to view, as well as 

to zoom in or out on the current report being viewed. The following table describes the function 

of each of the page view controls. 

Control Keystroke Function 

 Shift+F2 
Single Page: View the report one page at-a- 

time 

 Shift+F3 Continuous: View the report with all pages 
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displayed continuously 

 Shift+F4 

Multiple Pages:  based on the selected 

zoom, all possible pages are displayed to 

fill the viewer window 

 No keystroke 
Selected Zoom:  View the report at the 

percent size specified  

Saving Reports 

In order to facilitate the utilization of the information included in the eMaRC Plus Physician 

Reporting module reports, eMaRC Plus offers an extensive number of file formats in which the 

reports can be saved.  You can save the reports in different file formats in order to further 

analyze or format the data included differently or you can save the report as an image file to be 

placed in documents and presentations. You can save reports in any of the file formats listed 

under the Save As icon on the Main Toolbar of the Report Viewer: 
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Total Number of Physician Reports Received by Provider Report 

To run the Total Number of Physician Reports Received by Provider report, complete these 

steps: 

1. Click on the Reports icon  on the toolbar. 

Result: The Reports window opens. 

 

2. Select the Total Number of Physician Reports Received by Provider report and click Run 

Report.  

Result: The Date Range window opens. 

 

You can choose to enter a range of dates by Date Case Received or Diagnosis Date. 

3. Enter the desired date range for the date field of your choice and Click OK. In the example 

shown the date range of 2014/06/01 to 2014/06/11 is being entered for the Date Case 

Received. 

Result: The report opens in the eMaRC Plus Report Viewer window. 
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The Total Number of Physician Reports Received by Provider lists the overall total number 

of CDA documents received by submitting Provider during the user-specified date range 

4. When you are done viewing the report, click Print to print the report, Save to save the report, 

or Close to close the report. 

Number of Physician Reports Received by Provider and PTRID Report 

To run the Number of Physician Reports Received by Provider and PTRID report, complete 

these steps: 

1. Click on the Reports icon  on the toolbar. 

Result: The Reports window opens. 

 

2. Select the Number of Physician Reports Received by Provider and PTRID report and 

click Run Report.  

Result: The Date Range window opens. 
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You can choose to enter a range of dates by Date Case Received or Diagnosis Date. 

3. Enter the desired date range for the date field of your choice and Click OK. In the example 

shown the date range of 2014/06/01 to 2014/06/11 is being entered for the Date Case 

Received. 

Result: The report opens in the eMaRC Plus Report Viewer window. 

 

The Number of Physician Reports Received by Provider and PTRID lists the overall total 

number of CDA documents received by submitting Provider and PTRID during the user-

specified date range 

4. When you are done viewing the report, click Print to print the report, Save to save the report, 

or Close to close the report. 

 

Display Type Report     

The eMaRC Plus Physician Reporting module Display Type Report includes an at-a-glance 

overview of information for the Abstract Display and lists the field properties specified for each 

field included in the display type.  

To open the Display Type Report, complete the following steps: 

1. Click on the Reports icon  on the toolbar. 
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Result: The Reports window opens. 

 

2. Select the Display Type Report and click Run Report.  

Result: The report opens in the eMaRC Plus Report Viewer window. 

 

The Display Type Report contains these columns for each field included in the Abstract 

Display: 

Field Description 

Seq The standard NAACCR data item name for the field 
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Field Description 

Item No The standard NAACCR data item number for the 

field 

Data Item The standard NAACCR data item name for the field 

Section Name The name of the Section in which the field resides in 

the display type 

Default The user-specified default value (if any) that is 

initially displayed in the field 

Protected Denotes whether the field was specified as protected 

(i.e., value of field cannot be edited by user)  

Invisible Denotes whether the field was specified as invisible 

(i.e., included in the display type but not visible to 

the user) 

3. Close the report window. 
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Appendix A: Documentation of CDA Document Section Tables 
in eMaRC Plus Database 

Data_ActiveProblems 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

ConcernID_Root 

Allows related acts to be grouped.  Can represent history of problem as a series of 

observations over time 

ConcernID_Extension 

Extension that allows related acts to be grouped.  Can represent history of problem as a 

series of observations over time 

Concern_Status_Code 

Active (ongoing clinical activity is expected), suspended (concern that is set aside, period 

of remission), aborted (left against Medical Advice) completed (resolved, no longer 

tracked except for historical purposes) 

Concern_Effect_Time_Low Earliest time that the concern was active 

Concern_Effect_Time_High Date the concern was completed or aborted 

Problem_Ref_Root Unique ID Root that identifies the problem 

Problem_Ref_Ext Unique ID Extension that identifies the problem 

Problem_Code Coded value for the condition (e.g., diabetes, apnea, low blood count etc.) 

Problem_DisplayName Name given to the coded problem value (e.g., diabetes, apnea, low blood count etc.) 

Problem_CodesystemOID Code System OID for the problem code 

NAACCRProblem_Code_ICD9 NAACCR problem code translation (before Version 13, Comorbidities) 

NAACCRProblem_Code_ICD10 NAACCR problem code translation (Version 13, Secondary Diagnoses) 

Problem_ProblemType Indicates the type of problem (e.g., Symptom, Problem, Finding, Diagnosis, etc.) 

Problem_Effect_Time_Low Earliest point for which the condition is known to have existed (implied: Date of onset) 

Problem_Effect_Time_High Time at which the condition was no longer known to be true (implied:  Date of resolution) 

 

Data_Address 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

PatientStreetAddress1 Patient's street address, first line 

PatientStreetAddress2 Patient's street address, second line 

PatientCity Patient's city 

PatientState Patient's state 

PatientZipcode Patient's zip code 

PatientCounty Patient's county 

PatientCountry Patient's country 

PatientAddressBegin_Date The date the patient began living at the address 

PatientAddressEnd_Date The date the patient stopped living at the address 
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Data element name Data element description 

PatientAddressUse_Code How the address is used by the patient (e.g., home, work, vacation) 

PatientPhone_Number Patient's phone number 

PatientEmail Patient's email address 

 

Data_CancerDiagnosis 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN 

Unique identifier for the patient created by the facility (Medical Record 

Number) 

Dx_Effect_Time_Low Cancer diagnosis date 

Histo_Code Coded value for the histology 

Histo_DisplayName Name given to the coded histology value 

Histo_OID Code System Object Identifier (OID) for the histology code 

NAACCRHisto_Code NAACCR histology code translation 

Behavior_Code Coded value for the behavior 

Behavior_DisplayName Name given to the coded behavior value 

Behavior_OID Code System OID for the behavior code 

DiagConf_Code 

Coded value for diagnostic confirmation (best method used to confirm the 

presence of the cancer being reported) 

DiagConf_DisplayName Name given to the coded diagnostic confirmation value 

DiagConf_OID Code System OID for the diagnostic confirmation code 

PrimarySite_Code 

Coded value for primary site (anatomic location where the primary tumor 

originated) 

PrimarySite_DisplayName Name given to the coded primary site value 

PrimarySite_OID Code System OID for the primary site code 

NAACCRPrimarySite_Code NAACCR primary site code translation 

Laterality_Code 

Coded value for the laterality (side of a paired organ or side of the body on 

which the reportable tumor originated) code 

Laterality_DisplayName Name given to the coded laterality value 

Laterality_OID Code System OID for the laterality code 

TNMGroup_Code Coded value for the TNM Clinical Stage Group of the tumor/cancer 

TNMGroup_DisplayName Name given to the coded TNM Clinical Stage Group value 

TNMGroup_OID Code System OID for the TNM Clinical Stage Group code 

TNMDescriptor_Code 

Coded value for the TNM Clinical Stage Descriptor (identifies special cases 

that need separate data analysis) 

TNMDescriptor_DisplayName Name given to the coded TNM Clinical Stage Descriptor value 

TNMDescriptor_OID Code System OID for the TNM Clinical Stage Descriptor code 

TNMEdition_Code Coded value for the TNM Edition Number of the AJCC Staging Manual 

TNMEdition_DisplayName Name given to the coded TNM Edition Number value 

TNMEdition_OID Code System OID for the TNM Edition Number code 

TNMStagedBy_Code 

Coded value for TNM Clinical Staged By (the person who recorded the AJCC 

staging elements and stage group in the patient's medical record) 

TNMStagedBy_DisplayName Name given to the coded TNM Clinical Staged By value 
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Data element name Data element description 

TNMStagedBy_OID Code System OID for the TNM Clinical Staged By code 

TNMClinicalT_Code Coded value for the TNM Clinical Tumor 

TNMClinicalT_DisplayName Name given to the coded TNM Clinical Tumor value 

TNMClinicalT_OID Code System OID for the TNM Clinical Tumor Code 

TNMClinicalN_Code Coded value for the TNM Clinical Node 

TNMClinicalN_DisplayName Name given to the coded TNM Clinical Node value 

TNMClinicalN_OID Code System OID for the TNM Clinical Node Code 

TNMClinicalM_Code Coded value for the TNM Clinical Metastasis 

TNMClinicalM_DisplayName Name given to the coded TNM Clinical Metastasis value 

TNMClinicalM_OID Code System OID for the TNM Clinical Metastasis Code 

TNMPATHGROUP_OID Code System OID for the TNM Pathologic Stage Group code 

TNMPATHGROUP_DISPLAYNAME Name given to the coded TNM Pathologic Stage Group value 

TNMPATHGROUP_CODE Coded value for the TNM Pathologic Stage Group of the tumor/cancer 

TNMPATHDESCRIPTOR_CODE Coded value for the TNM Pathologic Stage Descriptor 

TNMPATHDESCRIPTOR_DISPLAYNAME Name given to the coded TNM Pathologic Stage Descriptor value 

TNMPATHDESCRIPTOR_OID Code System OID for the TNM Pathologic Stage Descriptor code 

TNMPATHSTAGEDBY_CODE Coded value for TNM Pathologic Staged By 

TNMPATHSTAGEDBY_DISPLAYNAME Name given to the coded TNM Pathologic Staged By value 

TNMPATHSTAGEDBY_OID Code System OID for the TNM Pathologic Staged By code 

TNMPATHT_CODE Coded value for the TNM Pathologic Tumor 

TNMPATHT_DISPLAYNAME Name given to the coded TNM Pathologic Tumor value 

TNMPATHT_OID Code System OID for the TNM Pathologic Tumor Code 

TNMPATHN_CODE Coded value for the TNM Pathologic Node 

TNMPATHN_DISPLAYNAME Name given to the coded TNM Pathologic Node value 

TNMPATHN_OID Code System OID for the TNM Pathologic Node Code 

TNMPATHM_CODE Coded value for the TNM Pathologic Metastasis 

TNMPATHM_DISPLAYNAME Name given to the coded TNM Pathologic Metastasis value 

TNMPATHM_OID Code System OID for the TNM Pathologic Metastasis Code 

HealthStatus_Code 

Coded value that represents the general health status of the patient (e.g., “alive 

and well”, “in remission”, “deceased”, etc.) 

HealthStatus_DisplayName Name given to the coded health status value 

HealthStatus_OID Code System OID for the health status code 

 

Data_Family_History 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

FamilyMember_Code Coded value that indicates the familial relationship of a person to the patient 

FamilyMember_DisplayName Name given to the coded family member value 

FamilyMember_OID Code System OID for the family member code 

FamilyMemberProblem_Code 

Coded value for the condition (e.g., diabetes, apnea, low blood count etc.) of the 

patient’s family member 

FamilyMemberProblem_DisplayName Name given to the coded family member problem value 
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Data element name Data element description 
FamilyMemberProblem_OID Code System OID for the family member problem code 

 

Data_Medications 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

Med_Effect_Time_Low Start time of the medication 

Med_Effect_Time_High 

End time of the medication regimen according to the information provided in the prescription 

or order 

Med_FreqValue 

Value that indicates the frequency of administration of the medication (taken together with 

the frequency units. E.g., Value=4, Units=Hours) 

Med_FreqUnit 

Units that indicate the frequency of administration of the medication (taken together with the 

frequency value. E.g., Value=4, Units=Hours) 

Med_RouteCode Coded value that indicates how the medication is received by the patient (by mouth, IV, etc.) 

Med_RouteDisplayName Name given to the coded route value 

Med_RouteOID Code System Object Identifier (OID) for the route code 

Med_SiteCode Coded value for the site of the body where the medication is administered 

Med_SiteDisplayName Name given to the coded body site value 

Med_SiteOID Code System Object Identifier (OID) for the body site code 

Med_DoseValue 

Value that indicates medication dose when a single dose is taken (used together with dose 

units. E.g., Value=2, Units=mg) 

Med_DoseUnit 

Units that indicate medication dose when a single dose is taken (used together with dose 

value. E.g., Value=2, Units=mg) 

Med_DoseLow 

Low value that indicates a medication dose range (used together with high dose value and 

units. E.g., Low value=1, High value=2, Units=Tablet) 

Med_DoseHigh 

High value that indicates a medication dose range (used together with low dose value and 

units. E.g., Low value=1, High value=2, Units=Tablet) 

Med_DoseLowUnits 

Units that indicate a medication dose range (used together with low and high dose values. 

E.g., Low value=1, High value=2, Units=Tablet) 

Med_DoseHighUnits 

Units that indicate a medication dose range (used together with low and high dose values. 

E.g., Low value=1, High value=2, Units=Tablet) 

Med_RateLow Low value that indicates a measurement of how fast the dose is given to the patient over time 

Med_RateHigh High value that indicates a measurement of how fast the dose is given to the patient over time 

Med_RateLowUnits 

Time unit for the low value that indicates a measurement of how fast the dose is given to the 

patient over time 

Med_RateHighUnits 

Time unit for the high value that indicates a measurement of how fast the dose is given to the 

patient over time 

Med_ProductCode Coded value  that represents the generic medication name (and strength if relevant) 

Med_ProductDisplayName Name given to the coded medication value 

Med_ProductOID Code System Object Identifier (OID) for the medication (product) code 

Med_BrandName Free text that indicates the brand name of the medication 

Med_NameOriginalText Corresponding narrative text for coded medication name 

Med_Category 

Indicates whether the medication has been determined to be chemo, BRM, or hormone 

according to NAACCR translation 
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Data_Medications_Admin 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

MedAdmin_Effect_Time_Low Start time of the medication administered 

MedAdmin_Effect_Time_High 

End time of the medication admininstered according to the information provided in the 

prescription or order 

MedAdmin_FreqValue 

Value that indicates the frequency of administration of the medication (taken together with 

the frequency units. E.g., Value=4, Units=Hours) 

MedAdmin_FreqUnit 

Units that indicate the frequency of administration of the medication (taken together with 

the frequency value. E.g., Value=4, Units=Hours) 

MedAdmin_RouteCode 

Coded value that indicates how the medication administered is received by the patient (by 

mouth, IV, etc.) 

MedAdmin_RouteDisplayName Name given to the coded route value 

MedAdmin_RouteOID Code System Object Identifier (OID) for the route code 

MedAdmin_SiteCode Coded value for the site of the body where the medication is administered 

MedAdmin_SiteDisplayName Name given to the coded body site value 

MedAdmin_SiteOID Code System Object Identifier (OID) for the body site code 

MedAdmin_DoseValue 

Value that indicates medication dose when a single dose is administered (used together 

with dose units. E.g., Value=2, Units=mg) 

MedAdmin_DoseUnit 

Units that indicate medication dose when a single dose is administered (used together with 

dose value. E.g., Value=2, Units=mg) 

MedAdmin_DoseLow 

Low value that indicates a medication dose range (used together with high dose value and 

units. E.g., Low value=1, High value=2, Units=Tablet) 

MedAdmin_DoseHigh 

High value that indicates a medication dose range (used together with low dose value and 

units. E.g., Low value=1, High value=2, Units=Tablet) 

MedAdmin_DoseLowUnits 

Units that indicate a medication dose range (used together with low and high dose values. 

E.g., Low value=1, High value=2, Units=Tablet) 

MedAdmin_DoseHighUnits 

Units that indicate a medication dose range (used together with low and high dose values. 

E.g., Low value=1, High value=2, Units=Tablet) 

MedAdmin_RateLow 

Low value that indicates a measurement of how fast the dose is given to the patient over 

time 

MedAdmin_RateHigh 

High value that indicates a measurement of how fast the dose is given to the patient over 

time 

MedAdmin_RateLowUnits 

Time unit for the low value that indicates a measurement of how fast the dose is given to 

the patient over time 

MedAdmin_RateHighUnits 

Time unit for the high value that indicates a measurement of how fast the dose is given to 

the patient over time 

MedAdmin_ProductCode 

Coded value  that represents the generic name (and strength if relevant) of the medication 

administered 

MedAdmin_ProductDisplayName Name given to the coded medication value 

MedAdmin_ProductOID Code System Object Identifier (OID) for the medication (product) code 

MedAdmin_BrandName Free text that indicates the brand name of the medication administered 

MedAdmin_NameOriginalText Corresponding narrative text for coded name of the medication administered 

MedAdmin_Category 

Indicates whether the medication has been determined to be chemo, BRM, or hormone 

according to NAACCR translation 
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Data_Narrative 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

CancerDiagnosis_Text 

Narrative description of the information about cancer diagnosis(es) that are currently 

being monitored for the patient 

TNMStageGroup_Text Narrative description of the Stage Group for the cancer diagnosis 

ActiveProblems_Text Narrative description of the conditions currently being monitored for the patient 

CodedResults_Text Narrative description of the relevant diagnostic procedures the patient received in the past 

Procedures_Text 

Narrative description of all interventional, surgical, diagnostic, or therapeutic procedures 

or treatments, pertinent to the patient historically at the time the document is generated 

RadiationOncology_Text Narrative description of the radiation treatment performed by a Radiation Oncologist 

Medications_Text 

Narrative description of the relevant medications for the patient, e.g., an ambulatory 

prescription list 

MedicationsAdministered_Text 

Narrative description of the relevant medications administered to a patient during the 

course of an encounter 

ProgressNote_Text 

Narrative description of the sequence of events from initial assessment to discharge for an 

encounter 

CarePlan_Text 

Narrative description of the expectations for care including proposals, goals, and order 

requests for monitoring, tracking, or improving the condition of the patient 

CodedSocialHistory_Text 

Narrative description of the person’s beliefs, home life, community life, work life, 

hobbies, and risky habits 

Payers_Text 

Narrative description of the patient’s payers, whether a ‘third party’ insurance, self-pay, 

other payer or guarantor, or some combination 

Assessment_Text 

Narrative description of the clinician's conclusions and working assumptions that will 

guide treatment of the patient. 

FamHist_Text 

Narrative description of the patient’s genetic relatives in terms of possible or relevant 

health risk factors that have a potential impact on the patient’s healthcare risk profile 

VitalSigns_Text 

Narrative description of the patient’s relevant vital signs for the context and use case of 

the document type, such as height, weight, and body mass index. 

 

Data_Patient 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

Patient_FN Patient’s first name 

Patient_LN Patient’s last name 

Patient_MN Patient’s middle name 

Patient_Suffix Patient’s name suffix 

Patient_Maiden Patient’s maiden name 

Patient_Alias Patient’s name alias 

Patient_GenderCode Coded value for patient’s gender 

Patient_GenderDisplayName Name given to the coded gender value 

Patient_GenderOID Coding System Object Identifier (OID) for the gender code 
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Data element name Data element description 

NAACCRPatient_GenderCode NAACCR gender code translation 

Patient_DOB Patient’s date of birth 

Patient_DOB_NullFl Null flavor value provided for patient’s date of birth, if no date value provided 

Patient_SSN Patient’s social security number 

Patient_EthnicCode Coded value for patient’s ethnicity 

Patient_EthnicDisplayName Name given to the coded ethnicity value 

Patient_EthnicOID Coding System Object Identifier (OID) for the ethnicity code 

NAACCRPatient_EthnicCode NAACCR ethnicity code translation 

Patient_StateOfBirth Patient’s state of birth 

Patient_CountryOfBirth Patient’s country of birth 

Patient_MaritalCode Coded value for patient’s marital status 

Patient_MaritalDisplayName Name given to the coded marital status value 

Patient_MaritalOID Coding System Object Identifier (OID) for the marital status code 

NAACCRPatient_MaritalCode NAACCR marital status code translation 

Patient_DecDate The date the patient died (if applicable) 

Patient_DecInd Indicates whether the patient is alive (“false”) or deceased (“true”) 

  

 

Data_Payers 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

SeqNum 

Number that indicates  the priority of the payment source (with 1 as the highest 

priority) 

Payer_Type_Code Coded value for the type of payer 

Payer_Type_DisplayName Name given to the payer type value 

Payer_Type_CodeSystemOID Code System Object Identifier (OID) for the payer type code 

NAACCRPayer_Type_Code NAACCR payer type code translation 

 

Data_Procedures 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN 

Unique identifier for the patient created by the facility (Medical Record 

Number) 

Procedure_Code Coded value for the procedure 

Procedure_DisplayName Name given to the coded procedure value 

Procedure_CodeSystemOID Coding System Object Identifier (OID) for the procedure code 

NAACCRProcedure_Code NAACCR procedure code translation 

Procedure_Status 

Indicates whether the procedure is completed, active (in progress), aborted, or 

cancelled 
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Data element name Data element description 

Procedure_EffectTime_Low Date/time the procedure began 

Procedure_EffectTime_High Date/time the procedure ended 

Procedure_EffectiveTime Date/time the procedure occurred 

Procedure_TargetSite_Code Coded value for the part of the body where the procedure was performed 

Procedure_TargetSite_DisplayName Name given to the coded body site value by the Coding system 

Procedure_TargetSite_CodeSystemOID Code System Object Identifier (OID) for the body site code 

Procedure_Problem_Ref_Root ID root that links the procedure to the problem 

Procedure_Problem_Ref_Ext ID extension that links the procedure to the problem 

Procedure_Performer_Entity_NPI NPI of individual provider who performed the procedure 

Procedure_Performer_Organization_NPI NPI of organization that performed the procedure 

 

Data_Provider 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN 

Unique identifier for the patient created by the facility (Medical Record 

Number) 

Author_NPI NPI number of the human that authored the document 

Author_FirstName First name of the human that authored the document 

Author_LastName Last name of the human that authored the document 

Author_Name_Person 

Full name of the human that authored the document (when not split out 

into first and last name) 

Author_Suffix Name suffix of the human that authored the document 

Author_Specialty_Code Coded value for the specialty of the human that authored the document 

Author_Specialty_DisplayName 

Name given to the specialty value of the human that authored the 

document 

Author_Specialty_OID 

Code System Object Identifier (OID) for specialty code of the human that 

authored the document 

Author_StreetAddress_Person Street address of the human that authored the document 

Author_City_Person City of the human that authored the document 

Author_State_Person State of the human that authored the document 

Author_Zip_Person Zip code of the human that authored the document 

Author_Country_Person Country of the human that authored the document 

Author_Phone_Person Phone number of the human that authored the document 

Author_Organization_NPI NPI number for the organization that authored the document 

Author_Organization_Name Name of the organization that authored the document 

Author_StreetAddress_Organization Street address of the organization that authored the document 

Author_City_Organization City of the organization that authored the document 

Author_State_Organization State of the organization that authored the document 

Author_Zip_Organization Zip code of the organization that authored the document 

Author_Country_Organization Country of the organization that authored the document 

Author_Phone_Organization Phone number of the organization that authored the document 
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Data element name Data element description 

Custodian_NPI 

NPI number of the organization that is in charge of maintaining the 

document 

Custodian_Name Name of the organization that is in charge of maintaining the document 

Custodian_StreetAddress 

Street address of the organization that is in charge of maintaining the 

document 

Custodian_City City of the organization that is in charge of maintaining the document 

Custodian_State State of the organization that is in charge of maintaining the document 

Custodian_Zip Zip code of the organization that is in charge of maintaining the document 

Custodian_Country Country of the organization that is in charge of maintaining the document 

Custodian_Phone 

Phone number of the organization that is in charge of maintaining the 

document 

ServiceEv_Effect_Time_Low Start time of the main act being documented 

ServiceEv_Effect_Time_High End time of the main act being documented 

ServiceEv_PhysNPI 

NPI number of the clinician who actually and principally carried out the 

service event 

ServiceEv_PhysLastName 

Last name of the clinician who actually and principally carried out the 

service event 

ServiceEv_PhysFirstName 

First name of the clinician who actually and principally carried out the 

service event 

ServiceEv_PhysName 

Full name of the clinician who actually and principally carried out the 

service event (when not split out into first and last name) 

ServiceEv_PhysSuffix 

Name suffix of the clinician who actually and principally carried out the 

service event 

ServiceEv_PhysSpecialty_Code 

Coded value for the specialty of the clinician who actually and principally 

carried out the service event 

ServiceEv_PhysSpecialty_DisplayName 

Name given to the coded specialty value of the clinician who actually and 

principally carried out the service event 

ServiceEv_PhysSpecialty_OID 

Code System Object Identifier (OID) for the specialty code of the clinician 

who actually and principally carried out the service event 

ServiceEv_Phys_StreetAddress 

Street address of the clinician who actually and principally carried out the 

service event 

ServiceEv_Phys_City 

City of the clinician who actually and principally carried out the service 

event 

ServiceEv_Phys_State 

State of the clinician who actually and principally carried out the service 

event 

ServiceEv_Phys_Zip 

Zip code of the clinician who actually and principally carried out the 

service event 

ServiceEv_Phys_Country 

Country of the clinician who actually and principally carried out the 

service event 

ServiceEv_Phys_Phone 

Phone number of the clinician who actually and principally carried out the 

service event 

ServiceEv_OrgNPI 

NPI number of the organization of the clinician who actually and 

principally carried out the service event 

ServiceEv_OrgName 

Name of the organization associated with the clinician who actually and 

principally carried out the service event 

ServiceEv_Org_StreetAddress 

Street address of the organization associated with clinician who actually 

and principally carried out the service event 

ServiceEv_Org_City 

City of the organization associated with the clinician who actually and 

principally carried out the service event 

ServiceEv_Org_State 

State of the organization associated with the clinician who actually and 

principally carried out the service event 
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Data element name Data element description 

ServiceEv_Org_Zip 

Zip code of the organization associated with the clinician who actually and 

principally carried out the service event 

ServiceEv_Org_Country 

Country of the organization associated with the clinician who actually and 

principally carried out the service event 

ServiceEv_Org_Phone 

Phone number of the organization associated with the clinician who 

actually and principally carried out the service event 

Encounter_EffectiveTime 

Date/time of the encompassing encounter, which represents the setting of 

the clinical encounter during which the documented act(s) or ServiceEvent 

occurred 

Encounter_Effect_Time_Low Start date/time of the encompassing encounter 

Encounter_Effect_Time_High End date/time of the encompassing encounter 

Encounter_PhysNPI 

NPI number of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_PhysLastName 

Last name of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_PhysFirstName 

First name of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_PhysName 

Full name of the provider having primary legal responsibility for the 

encompassing encounter (when not split out into first and last name) 

Encounter_PhysSuffix 

Name suffix of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_PhysSpecialty_Code 

Coded value for the specialty of the provider having primary legal 

responsibility for the encompassing encounter 

Encounter_PhysSpecialty_DisplayName 

Name given to the coded specialty value of the provider having primary 

legal responsibility for the encompassing encounter 

Encounter_PhysSpecialty_OID 

Code System OID for the specialty code of the provider having primary 

legal responsibility for the encompassing encounter 

Encounter_Phys_StreetAddress 

Street address of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_Phys_City 

City of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_Phys_State 

State of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_Phys_Zip 

Zip code of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_Phys_Country 

Country of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_Phys_Phone 

Phone number of the provider having primary legal responsibility for the 

encompassing encounter 

Encounter_OrgNPI 

NPI number of the organization having primary legal responsibility for the 

encompassing encounter 

Encounter_OrgName 

Name of the organization having primary legal responsibility for the 

encompassing encounter 

Encounter_Org_StreetAddress 

Street address of the organization having primary legal responsibility for 

the encompassing encounter 

Encounter_Org_City 

City of the organization having primary legal responsibility for the 

encompassing encounter 

Encounter_Org_State 

State of the organization having primary legal responsibility for the 

encompassing encounter 

Encounter_Org_Zip 

Zip code of the organization having primary legal responsibility for the 

encompassing encounter 
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Data element name Data element description 

Encounter_Org_Country 

Country of the organization having primary legal responsibility for the 

encompassing encounter 

Encounter_Org_Phone 

Phone number of the organization having primary legal responsibility for 

the encompassing encounter 

ProvReferredFrom_NPI 

NPI number of the provider that referred the patient to the reporting 

facility 

ProvReferredFrom_LastName Last name of the provider that referred the patient to the reporting facility 

ProvReferredFrom_FirstName First name of the provider that referred the patient to the reporting facility 

ProvReferredFrom_Name 

Full name of the provider that referred the patient to the reporting facility 

(when not split out into first and last name) 

ProvReferredFrom_Suffix 

Name suffix of the provider that referred the patient to the reporting 

facility 

ProvReferredFrom_StreetAddress 

Street address of the provider that referred the patient to the reporting 

facility 

ProvReferredFrom_City City of the provider that referred the patient to the reporting facility 

ProvReferredFrom_State State of the provider that referred the patient to the reporting facility 

ProvReferredFrom_Zip Zip code of the provider that referred the patient to the reporting facility 

ProvReferredFrom_Country Country of the provider that referred the patient to the reporting facility 

ProvReferredFrom_Phone 

Phone number of the provider that referred the patient to the reporting 

facility 

ProvReferredFrom_OrgNPI 

NPI number of the organization that referred the patient to the reporting 

facility 

ProvReferredFrom_OrgName Name of the organization that referred the patient to the reporting facility 

ProvReferredFrom_Org_StreetAddress 

Street address of the organization that referred the patient to the reporting 

facility 

ProvReferredFrom_Org_City City of the organization that referred the patient to the reporting facility 

ProvReferredFrom_Org_State State of the organization that referred the patient to the reporting facility 

ProvReferredFrom_Org_Zip 

Zip code of the organization that referred the patient to the reporting 

facility 

ProvReferredFrom_Org_Country 

Country of the organization that referred the patient to the reporting 

facility 

ProvReferredFrom_Org_Phone 

Phone number of the organization that referred the patient to the reporting 

facility 

ProvReferredTo_NPI NPI number of the provider to whom the patient was referred 

ProvReferredTo_LastName Last name of the provider to whom the patient was referred 

ProvReferredTo_FirstName First name of the provider to whom the patient was referred 

ProvReferredTo_Name 

Full name of the provider to whom the patient was referred (when not split 

out into first and last name) 

ProvReferredTo_Suffix Name suffix of the provider to whom the patient was referred 

ProvReferredTo_StreetAddress Street address of the provider to whom the patient was referred 

ProvReferredTo_City City of the provider to whom the patient was referred 

ProvReferredTo_State State of the provider to whom the patient was referred 

ProvReferredTo_Zip Zip code of the provider to whom the patient was referred 

ProvReferredTo_Country Country of the provider to whom the patient was referred 

ProvReferredTo_Phone Phone number of the provider to whom the patient was referred 

ProvReferredTo_OrgNPI NPI number of the organization to whom the patient was referred 
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Data element name Data element description 

ProvReferredTo_OrgName Name of the organization to whom the patient was referred 

ProvReferredTo_Org_StreetAddress Street address of the organization to whom the patient was referred 

ProvReferredTo_Org_City City of the organization to whom the patient was referred 

ProvReferredTo_Org_State State of the organization to whom the patient was referred 

ProvReferredTo_Org_Zip Zip code of the organization to whom the patient was referred 

ProvReferredTo_Org_Country Country of the organization to whom the patient was referred 

ProvReferredTo_Org_Phone Phone number of the organization to whom the patient was referred 

 

Data_Race 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

Patient_RaceCode Coded value for patient's race 

Patient_RaceDisplayName Name given to the coded race value 

Patient_RaceOID Coding System Object Identifier (OID) for the race code 

NAACCRPatient_RaceCode NAACCR race code translation 

Author_ModelName The model name/number of the software device that created the CDA document 

Author_SoftwareName The software name of the software device that created the CDA document 

 

Data_Results 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN 

Unique identifier for the patient created by the facility (Medical Record 

Number) 

Results_Procedure_Code Coded value for the type of procedure performed to obtain the test result 

Results_Procedure_DisplayName Name given to the coded procedure value 

Results_Procedure_CodeSystemOID Code System Object Identifier (OID) for the procedure code 

Results_Procedure_Effect_Time_Low Earliest time that the procedure was performed 

Results_Procedure_Effect_Time_High Latest time that the procedure was performed 

TestType_Code Coded value for the type of test performed 

TestType_DisplayName Name given to the test type code 

TestType_CodeSystemOID Code System OID for the test type code 

Result_Value_Text Text test result for non-quantitative tests 

Result_Value_Quant Test result value for quantitative tests 

Result_Value_Units Test result units that go with value for quantitative tests 

Result_InterpretationCode Coded value for a qualitative interpretation of the observation 

Result_InterpretationCode_DisplayName Name given to the interpretation code 

Result_InterpretationCode_OID Code System OID for the interpretation code 
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Data element name Data element description 

Result_EffectTime Date/time of test result 

LabName 

Name of the author of the observation (e.g., the Laboratory that performed 

the test) 

LabID_Root 

ID root of the author of the observation. The root indicates the "assigning 

authority" (e.g., CLIA) of the ID 

LabID_Extension 

ID extension of the author of the observation (e.g., CLIA # of the Laboratory 

that performed the test) 

 

Data_Radiation 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN 

Unique identifier for the patient created by the facility (Medical Record 

Number) 

RADREGMODALITY_CODE 
Coded value for the dominant modality of radiation therapy used to deliver 

the regional dose 

RADREGMODALITY_DISPLAYNAME Name given to the radiation treatment regional modality code 

RADREGMODALITY_OID Code System OID for the radiation treatment regional modality code 

NAACCRRADREGMODALITY_CODE  

RADBOOSTMODALITY_CODE Coded value for the radiation treatment—boost modality 

RADBOOSTMODALITY_DISPLAYNAME Name given to the radiation treatment—boost modality code 

RADBOOSTMODALITY_OID Code System OID for the radiation treatment—boost modality code 

RADBOOSTMODALITY_EFFECTIVETIME Date/time that the radiation treatment—boost modality was given 

RADREGMODALITY_EFFECTIVETIME Date/time that the radiation treatment regional modality was given 

 

Data_Treatment_Plan 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

PlannedProc_Code Coded value for procedure that is planned to be performed in the future 

PlannedProc_DisplayName Name given to the planned procedure code  

PlannedProc_OID Code System OID for the planned procedure code 

PlannedProc_EffectiveTime Date/time the procedure is planned to take place 

PlannedMed_Code Coded value for medication that is planned to be given in the future 

PlannedMed_DisplayName Name given to the planned medication code 

PlannedMed_OID Code System OID for the planned medication code 
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Data_SocialHistory 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

SocialHx_LOINC Coded value that identifies the data element (occupation, industry, or smoking status) 

SocialHx_Code Coded value for the data element (occupation, industry, or smoking status) 

SocialHx_DisplayName Name given to the coded data value 

SocialHx_OID Code System Object Identifier (OID) for the occupation, industry, or smoking status code 

SocialHx_OriginalText 

Corresponding narrative text for coded information ( occupation, industry, or smoking 

status) 

SocialHx_Effect_Low Earliest date the data value was known by the facility 

SocialHx_Effect_High Most recent date the data value was known by the facility 

SocialHx_Effect_Time Date the data value was known by the facility 

 

Data_VitalSign 

Data element name Data element description 

Document_Date Date the CDA Document is created by the Physician EHR 

DocumentID Unique identifier for the CDA Document created by the Physician EHR 

FacilityID NPI or other unique ID number for the facility 

Patient_MRN Unique identifier for the patient created by the facility (Medical Record Number) 

VitalSignType_Code Coded value that identifies the type of vital sign result (e.g., height, weight) 

VitalSignType_DisplayName Name given to the coded vital sign type 

VitalSign_Value Vital sign quantitative value 

VitalSign_Units Units related to vital sign value 

VitalSign_EffectiveTime Date/Time vital sign value was recorded 
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Appendix B: Abstract Display Report with Defaults  

              
 Seq  Item No   Data Item  Section Name  Default Value   Protected  Invisible  Critical   

                        
                        
 1  9961  Weight  SITE-SPECIFIC DATA ITEM (SSDI)              

                        
 2  3827  Estrogen Receptor Summary  SITE-SPECIFIC DATA ITEM (SSDI)              

                        
 3  3838  Gleason Patterns Clinical  SITE-SPECIFIC DATA ITEM (SSDI)              

                        
 4  3920  PSA (Prostatic Specific 

Antigen) Lab Value 
 SITE-SPECIFIC DATA ITEM (SSDI)              

                        
 5  2230  Name--Last  PATIENT IDENTIFICATION  UNKNOWN            

                        
 6  2240  Name--First  PATIENT IDENTIFICATION              

                        
 7  2250  Name--Middle  PATIENT IDENTIFICATION              

                        
 8  2390  Name--Maiden  PATIENT IDENTIFICATION              

                        
 9  2280  Name--Alias  PATIENT IDENTIFICATION              

                        
 10  2260  Name--Prefix  PATIENT IDENTIFICATION              

                        
 11  2270  Name--Suffix  PATIENT IDENTIFICATION              

                        
 12  2290  Name--Spouse/Parent  PATIENT IDENTIFICATION              

                        
 13  2320  Social Security Number  PATIENT IDENTIFICATION  999999999            

                        
 14  220  Sex  PATIENT IDENTIFICATION  9            

                        
 15  240  Date of Birth  PATIENT IDENTIFICATION              

                        
 16  241  Date of Birth Flag  PATIENT IDENTIFICATION              

                        
 17  230  Age at Diagnosis  PATIENT IDENTIFICATION  999            

                        
 18  150  Marital Status at DX  PATIENT IDENTIFICATION  9            

 19  2315  Medicare Beneficiary 
Identifier 

 PATIENT IDENTIFICATION              

                        
 20  2330  Addr at DX--No & Street  DEMOGRAPHICS  UNKNOWN            

                        
 21  2335  Addr at DX--Supplementl  DEMOGRAPHICS              

                        
 22  70  Addr at DX--City  DEMOGRAPHICS  UNKNOWN            

                        
 23  80  Addr at DX--State  DEMOGRAPHICS  US            

                        
 24  100  Addr at DX--Postal Code  DEMOGRAPHICS  999999999            

                        
 25  90  County at DX Reported  DEMOGRAPHICS  999            

                        
 26  2350  Addr Current--No & Street  DEMOGRAPHICS  UNKNOWN            

                        
 27  2355  Addr Current--Supplementl  DEMOGRAPHICS              

                        
 28  1810  Addr Current--City  DEMOGRAPHICS  UNKNOWN            
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 29  1820  Addr Current--State  DEMOGRAPHICS  US            

                        
 30  1830  Addr Current--Postal Code  DEMOGRAPHICS  999999999            

                        
 31  1832  Addr Current--Country  DEMOGRAPHICS  USA            

                        
 32  1840  County--Current  DEMOGRAPHICS  999            

                        
 33  96  County at DX Geocode2010  DEMOGRAPHICS              

                        
 34  2360  Telephone  DEMOGRAPHICS  9999999999            

                        
 35  252  Birthplace--State  DEMOGRAPHICS  ZZ            

                        
 36  254  Birthplace--Country  DEMOGRAPHICS  ZZU            

 37  160  Race 1  DEMOGRAPHICS              

                        
 38  161  Race 2  DEMOGRAPHICS              

                        
 39  162  Race 3  DEMOGRAPHICS              

                        
 40  163  Race 4  DEMOGRAPHICS              

                        
 41  164  Race 5  DEMOGRAPHICS              

                        
 42  190  Spanish/Hispanic Origin  DEMOGRAPHICS  9            

                        
 43  310  Text--Usual Occupation  DEMOGRAPHICS  unknown            

                        
 44  290  Occupation Source  DEMOGRAPHICS  0            

                        
 45  270  Census Occ Code 1970-2000  DEMOGRAPHICS              

                        
 46  282  Census Occ Code 2010 CDC  DEMOGRAPHICS              

                        
 47  320  Text--Usual Industry  DEMOGRAPHICS  unknown            

                        
 48  300  Industry Source  DEMOGRAPHICS  0            

                        
 49  280  Census Ind Code 1970-2000  DEMOGRAPHICS              

                        
 50  272  Census Ind Code 2010 CDC  DEMOGRAPHICS              

                        
 51  330  Census Occ/Ind Sys 70-00  DEMOGRAPHICS              

                        
 52  390  Date of Diagnosis  CANCER IDENTIFICATION              

                        
 53  391  Date of Diagnosis Flag  CANCER IDENTIFICATION              

                        
 54  560  Sequence Number--Hospital  CANCER IDENTIFICATION  00            

 55  2580  Text--Primary Site Title  CANCER IDENTIFICATION              

                        
 56  400  Primary Site  CANCER IDENTIFICATION              

                        
 57  410  Laterality  CANCER IDENTIFICATION              

                        
 58  2590  Text--Histology Title  CANCER IDENTIFICATION              

                        
 59  522  Histologic Type ICD-O-3  CANCER IDENTIFICATION              
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 Seq  Item No   Data Item  Section Name  Default Value   Protected  Invisible  Critical   

                        
                        
 60  523  Behavior Code ICD-O-3  CANCER IDENTIFICATION              

                        
 61  440  Grade  CANCER IDENTIFICATION              

                        
 62  3843  Grade Clinical  CANCER IDENTIFICATION              

                        
 63  441  Grade Path Value  CANCER IDENTIFICATION              

                        
 64  3844  Grade Pathological  CANCER IDENTIFICATION              

                        
 65  3845  Grade Post Therapy  CANCER IDENTIFICATION              

                        
 66  490  Diagnostic Confirmation  CANCER IDENTIFICATION  9            

                        
 67  2570  Text--DX Proc--Path  TEXT DIAGNOSIS              

                        
 68  2520  Text--DX Proc--PE  TEXT DIAGNOSIS              

                        
 69  2530  Text--DX Proc--X-ray/scan  TEXT DIAGNOSIS              

                        
 70  2540  Text--DX Proc--Scopes  TEXT DIAGNOSIS              

                        
 71  2550  Text--DX Proc--Lab Tests  TEXT DIAGNOSIS              

                        
 72  2680  Text--Remarks  TEXT DIAGNOSIS              

                         73  2690  Text--Place Of Diagnosis  TEXT DIAGNOSIS              

                        
 74  995  AJCC ID  STAGE/PROGNOSTIC FACTORS              

                        
 75  3800  Schema ID  STAGE/PROGNOSTIC FACTORS              

                        
 76  3926  Schema Discriminator 1  STAGE/PROGNOSTIC FACTORS              

                        
 77  2600  Text--Staging  STAGE/PROGNOSTIC FACTORS              

                        
 78  1060  TNM Edition Number  STAGE/PROGNOSTIC FACTORS              

                        
 79  970  TNM Clin Stage Group  STAGE/PROGNOSTIC FACTORS              

                        
 80  940  TNM Clin T  STAGE/PROGNOSTIC FACTORS              

                        
 81  950  TNM Clin N  STAGE/PROGNOSTIC FACTORS              

                        
 82  960  TNM Clin M  STAGE/PROGNOSTIC FACTORS              

                        
 83  980  TNM Clin Descriptor  STAGE/PROGNOSTIC FACTORS              

                        
 84  990  TNM Clin Staged By  STAGE/PROGNOSTIC FACTORS              

                        
 85  910  TNM Path Stage Group  STAGE/PROGNOSTIC FACTORS              

                        
 86  880  TNM Path T  STAGE/PROGNOSTIC FACTORS              

                        
 87  890  TNM Path N  STAGE/PROGNOSTIC FACTORS              

                        
 88  900  TNM Path M  STAGE/PROGNOSTIC FACTORS              

                        
 89  920  TNM Path Descriptor  STAGE/PROGNOSTIC FACTORS              
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 Seq  Item No   Data Item  Section Name  Default Value   Protected  Invisible  Critical   

                        
                        
 90  930  TNM Path Staged By  STAGE/PROGNOSTIC FACTORS              

 91  1004  AJCC TNM Clin Stage Group  STAGE/PROGNOSTIC FACTORS              

                        
 92  1001  AJCC TNM Clin T  STAGE/PROGNOSTIC FACTORS              

                        
 93  1002  AJCC TNM Clin N  STAGE/PROGNOSTIC FACTORS              

                        
 94  1003  AJCC TNM Clin M  STAGE/PROGNOSTIC FACTORS              

                        
 95  1014  AJCC TNM Path Stage 

Group 
 STAGE/PROGNOSTIC FACTORS              

                        
 96  1011  AJCC TNM Path T  STAGE/PROGNOSTIC FACTORS              

                        
 97  1012  AJCC TNM Path N  STAGE/PROGNOSTIC FACTORS              

                        
 98  1013  AJCC TNM Path M  STAGE/PROGNOSTIC FACTORS              

                        
 99  820  Regional Nodes Positive  STAGE/PROGNOSTIC FACTORS  99            

                        
 100  830  Regional Nodes Examined  STAGE/PROGNOSTIC FACTORS  99            

                        
 101  759  SEER Summary Stage 2000  STAGE/PROGNOSTIC FACTORS              

                        
 102  764  Summary Stage 2018  STAGE/PROGNOSTIC FACTORS              

                        
 103  3769  Over-ride CS 20  STAGE/PROGNOSTIC FACTORS              

                        
 104  3110  Comorbid/Complication 1  STAGE/PROGNOSTIC FACTORS              

                        
 105  3120  Comorbid/Complication 2  STAGE/PROGNOSTIC FACTORS              

                        
 106  3130  Comorbid/Complication 3  STAGE/PROGNOSTIC FACTORS              

                        
 107  3140  Comorbid/Complication 4  STAGE/PROGNOSTIC FACTORS              

                        
 108  3150  Comorbid/Complication 5  STAGE/PROGNOSTIC FACTORS              

 109  3160  Comorbid/Complication 6  STAGE/PROGNOSTIC FACTORS              

                        
 110  3161  Comorbid/Complication 7  STAGE/PROGNOSTIC FACTORS              

                        
 111  3162  Comorbid/Complication 8  STAGE/PROGNOSTIC FACTORS              

                        
 112  3163  Comorbid/Complication 9  STAGE/PROGNOSTIC FACTORS              

                        
 113  3164  Comorbid/Complication 10  STAGE/PROGNOSTIC FACTORS              

                        
 114  3780  Secondary Diagnosis 1  STAGE/PROGNOSTIC FACTORS              

                        
 115  3782  Secondary Diagnosis 2  STAGE/PROGNOSTIC FACTORS              

                        
 116  3784  Secondary Diagnosis 3  STAGE/PROGNOSTIC FACTORS              

                        
 117  3786  Secondary Diagnosis 4  STAGE/PROGNOSTIC FACTORS              

                        
 118  3788  Secondary Diagnosis 5  STAGE/PROGNOSTIC FACTORS              

                        
 119  3790  Secondary Diagnosis 6  STAGE/PROGNOSTIC FACTORS              
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 120  3792  Secondary Diagnosis 7  STAGE/PROGNOSTIC FACTORS              

                        
 121  3794  Secondary Diagnosis 8  STAGE/PROGNOSTIC FACTORS              

                        
 122  3796  Secondary Diagnosis 9  STAGE/PROGNOSTIC FACTORS              

                        
 123  3798  Secondary Diagnosis 10  STAGE/PROGNOSTIC FACTORS              

                        
 124  3650  NPCR Derived Clin Stg Grp  STAGE/PROGNOSTIC FACTORS              

                        
 125  540  Reporting Facility  FACILITY SPECIFIC INFORMATION              

                        
 126  545  NPI--Reporting Facility  FACILITY SPECIFIC INFORMATION              

 127  500  Type Of Reporting Source  FACILITY SPECIFIC INFORMATION  4            

                        
 128  2300  Medical Record Number  FACILITY SPECIFIC INFORMATION  UNK            

                        
 129  630  Primary Payer at DX  FACILITY SPECIFIC INFORMATION  99            

                        
 130  2465  NPI--Physician--Managing  FACILITY SPECIFIC INFORMATION              

                        
 131  2485  NPI--Physician--Prim Surg  FACILITY SPECIFIC INFORMATION              

                        
 132  580  Date of 1st Contact  FACILITY SPECIFIC INFORMATION              

                        
 133  581  Date of 1st Contact Flag  FACILITY SPECIFIC INFORMATION              

                        
 134  610  Class Of Case  FACILITY SPECIFIC INFORMATION  10            

                        
 135  501  Casefinding Source  FACILITY SPECIFIC INFORMATION  30            

                        
 136  2495  NPI--Physician 3  FACILITY SPECIFIC INFORMATION              

                        
 137  2505  NPI--Physician 4  FACILITY SPECIFIC INFORMATION              

                        
 138  1285  RX Summ--Treatment Status  TREATMENT - 1ST COURSE              

                        
 139  1270  Date 1st Crs RX CoC  TREATMENT - 1ST COURSE              

                        
 140  1271  Date 1st Crs RX CoC Flag  TREATMENT - 1ST COURSE              

                        
 141  1260  Date Initial RX SEER  TREATMENT - 1ST COURSE              

                        
 142  1261  Date Initial RX SEER Flag  TREATMENT - 1ST COURSE              

                        
 143  2560  Text--DX Proc--Op  TREATMENT - 1ST COURSE              

                        
 144  2610  RX Text--Surgery  TREATMENT - 1ST COURSE              

 145  1200  RX Date Surgery  TREATMENT - 1ST COURSE              

                        
 146  1201  RX Date Surgery Flag  TREATMENT - 1ST COURSE              

                        



eMaRC Plus Physician Reporting Module  Appendix B: Abstract Display Report with Defaults 

Version 9.0, Aug 2022  143 

                     

 Seq  Item No   Data Item  Section Name  Default Value   Protected  Invisible  Critical   

                        
                        
 147  3170  RX Date Mst Defn Srg  TREATMENT - 1ST COURSE              

                        
 148  3171  RX Date Mst Defn Srg Flag  TREATMENT - 1ST COURSE              

                        
 149  670  RX Hosp--Surg Prim Site  TREATMENT - 1ST COURSE              

                        
 150  1290  RX Summ--Surg Prim Site  TREATMENT - 1ST COURSE              

                        
 151  1340  Reason for No Surgery  TREATMENT - 1ST COURSE              

                        
 152  2620  RX Text--Radiation (Beam)  TREATMENT - 1ST COURSE              

                        
 153  2630  RX Text--Radiation Other  TREATMENT - 1ST COURSE              

                        
 154  1210  RX Date Radiation  TREATMENT - 1ST COURSE              

                        
 155  1211  RX Date Radiation Flag  TREATMENT - 1ST COURSE              

                        
 156  1506  Phase I Radiation Treatment 

Modality 
 TREATMENT - 1ST COURSE              

                        
 157  1570  Rad--Regional RX Modality  TREATMENT - 1ST COURSE              

                        
 158  3200  Rad--Boost RX Modality  TREATMENT - 1ST COURSE              

                        
 159  690  RX Hosp--Radiation  TREATMENT - 1ST COURSE              

                        
 160  1360  RX Summ--Radiation  TREATMENT - 1ST COURSE              

                        
 161  1430  Reason for No Radiation  TREATMENT - 1ST COURSE              

                        
 162  1380  RX Summ--Surg/Rad Seq  TREATMENT - 1ST COURSE              

 163  2640  RX Text--Chemo  TREATMENT - 1ST COURSE              

                        
 164  1220  RX Date Chemo  TREATMENT - 1ST COURSE              

                        
 165  1221  RX Date Chemo Flag  TREATMENT - 1ST COURSE              

                        
 166  700  RX Hosp--Chemo  TREATMENT - 1ST COURSE              

                        
 167  1390  RX Summ--Chemo  TREATMENT - 1ST COURSE              

                        
 168  2650  RX Text--Hormone  TREATMENT - 1ST COURSE              

                        
 169  1230  RX Date Hormone  TREATMENT - 1ST COURSE              

                        
 170  1231  RX Date Hormone Flag  TREATMENT - 1ST COURSE              

                        
 171  710  RX Hosp--Hormone  TREATMENT - 1ST COURSE              

                        
 172  1400  RX Summ--Hormone  TREATMENT - 1ST COURSE              

                        
 173  2660  RX Text--BRM  TREATMENT - 1ST COURSE              

                        
 174  1240  RX Date BRM  TREATMENT - 1ST COURSE              

                        
 175  1241  RX Date BRM Flag  TREATMENT - 1ST COURSE              

                        
 176  720  RX Hosp--BRM  TREATMENT - 1ST COURSE              
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 177  1410  RX Summ--BRM  TREATMENT - 1ST COURSE              

                        
 178  1639  RX Summ--Systemic/Sur Seq  TREATMENT - 1ST COURSE              

                        
 179  2670  RX Text--Other  TREATMENT - 1ST COURSE              

                        
 180  1250  RX Date Other  TREATMENT - 1ST COURSE              

 181  1251  RX Date Other Flag  TREATMENT - 1ST COURSE              

                        
 182  730  RX Hosp--Other  TREATMENT - 1ST COURSE              

                        
 183  1420  RX Summ--Other  TREATMENT - 1ST COURSE              

                        
 184  1296  RX Summ--Reg LN 

Examined 
 TREATMENT - 1ST COURSE  99            

                        
 185  672  RX Hosp--Scope Reg LN Sur  TREATMENT - 1ST COURSE  9            

                        
 186  1292  RX Summ--Scope Reg LN 

Sur 
 TREATMENT - 1ST COURSE  9            

                        
 187  674  RX Hosp--Surg Oth Reg/Dis  TREATMENT - 1ST COURSE  9            

                        
 188  1294  RX Summ--Surg Oth Reg/Dis  TREATMENT - 1ST COURSE  9            

                        
 189  3250  RX Summ--Transplnt/Endocr  TREATMENT - 1ST COURSE  99            

                        
 190  1760  Vital Status  FOLLOW UP/DEATH  1            

                        
 191  1750  Date of Last Contact  FOLLOW UP/DEATH              

                        
 192  1751  Date of Last Contact Flag  FOLLOW UP/DEATH              

                        
 193  1942  Place of Death--State  FOLLOW UP/DEATH              

                        
 194  1944  Place of Death--Country  FOLLOW UP/DEATH              

                        
 195  1910  Cause Of Death  FOLLOW UP/DEATH  0000            

                        
 196  1930  Autopsy  FOLLOW UP/DEATH  0            

                        
 197  1920  ICD Revision Number  FOLLOW UP/DEATH  0            

                        
 198  2440  Following Registry  FOLLOW UP/DEATH              

 199  2475  NPI--Physician--Follow-Up  FOLLOW UP/DEATH              

                        
 200  2410  Institution Referred From  FOLLOW UP/DEATH              

                        
 201  2415  NPI--Inst Referred From  FOLLOW UP/DEATH              

                        
 202  2420  Institution Referred To  FOLLOW UP/DEATH              

                        
 203  2425  NPI--Inst Referred To  FOLLOW UP/DEATH              

                        
 204  2112  Date Case Report Loaded  SYSTEM FIELDS              

                        
 205  2090  Date Case Completed  SYSTEM FIELDS              

                        
 206  2100  Date Case Last Changed  SYSTEM FIELDS              
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 207  2110  Date Case Report Exported  SYSTEM FIELDS              

                        
 208  2170  Vendor Name  SYSTEM FIELDS  eMaRC 7.0            

                        
 209  570  Abstracted By  SYSTEM FIELDS              

                        
 210  1790  Follow-Up Source  SYSTEM FIELDS  9            

                        
 211  1791  Follow-Up Source Central  SYSTEM FIELDS  00            

                        
 212  2116  ICD-O-3 Conversion Flag  SYSTEM FIELDS  0            

                        
 213  180  Race Coding Sys--Original  SYSTEM FIELDS  9            

                        
 214  170  Race Coding Sys--Current  SYSTEM FIELDS  7            

                        
 215  450  Site Coding Sys--Current  SYSTEM FIELDS  5            

                        
 216  460  Site Coding Sys--Original  SYSTEM FIELDS  5            

 217  470  Morph Coding Sys--Current  SYSTEM FIELDS  8            

                        
 218  480  Morph Coding Sys--Originl  SYSTEM FIELDS  8            

                        
 219  1460  RX Coding System--Current  SYSTEM FIELDS  06            

                        
 220  10  Record Type  SYSTEM FIELDS  A            

                        
 221  50  NAACCR Record Version  SYSTEM FIELDS  180            

                        
 222  2508  EHR Reporting  SYSTEM FIELDS              
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OID Registry 

2.16.840.1.113883.3.520.4.40 Reporting Facility Identification Number for Alabama 

2.16.840.1.113883.3.520.4.41 Reporting Facility Identification Number for Alaska 

2.16.840.1.113883.3.520.4.42 Reporting Facility Identification Number for American Samoa 

2.16.840.1.113883.3.520.4.43 Reporting Facility Identification Number for Arizona 

2.16.840.1.113883.3.520.4.44 Reporting Facility Identification Number for Arkansas 

2.16.840.1.113883.3.520.4.45 Reporting Facility Identification Number for California 

2.16.840.1.113883.3.520.4.46 Reporting Facility Identification Number for Colorado 

2.16.840.1.113883.3.520.4.47 Reporting Facility Identification Number for Connecticut 

2.16.840.1.113883.3.520.4.48 Reporting Facility Identification Number for District of Columbia 

2.16.840.1.113883.3.520.4.49 Reporting Facility Identification Number for Delaware 

2.16.840.1.113883.3.520.4.50 Reporting Facility Identification Number for Florida 

2.16.840.1.113883.3.520.4.51 Reporting Facility Identification Number for Georgia 

2.16.840.1.113883.3.520.4.52 Reporting Facility Identification Number for Guam 

2.16.840.1.113883.3.520.4.53 Reporting Facility Identification Number for Hawaii 

2.16.840.1.113883.3.520.4.54 Reporting Facility Identification Number for Idaho 

2.16.840.1.113883.3.520.4.55 Reporting Facility Identification Number for Illinois 

2.16.840.1.113883.3.520.4.56 Reporting Facility Identification Number for Indiana 

2.16.840.1.113883.3.520.4.57 Reporting Facility Identification Number for Iowa 

2.16.840.1.113883.3.520.4.58 Reporting Facility Identification Number for Kansas 

2.16.840.1.113883.3.520.4.59 Reporting Facility Identification Number for Kentucky 

2.16.840.1.113883.3.520.4.60 Reporting Facility Identification Number for Louisiana 

2.16.840.1.113883.3.520.4.61 Reporting Facility Identification Number for Maine 

2.16.840.1.113883.3.520.4.62 Reporting Facility Identification Number for Maryland 

2.16.840.1.113883.3.520.4.63 Reporting Facility Identification Number for Massachusetts 

2.16.840.1.113883.3.520.4.64 Reporting Facility Identification Number for Michigan 

2.16.840.1.113883.3.520.4.65 Reporting Facility Identification Number for Minnesota 

2.16.840.1.113883.3.520.4.66 Reporting Facility Identification Number for Mississippi 

2.16.840.1.113883.3.520.4.67 Reporting Facility Identification Number for Missouri 

2.16.840.1.113883.3.520.4.68 Reporting Facility Identification Number for Montana 

2.16.840.1.113883.3.520.4.69 Reporting Facility Identification Number for Nebraska 

2.16.840.1.113883.3.520.4.70 Reporting Facility Identification Number for Nevada 

2.16.840.1.113883.3.520.4.71 Reporting Facility Identification Number for New Hampshire 

2.16.840.1.113883.3.520.4.72 Reporting Facility Identification Number for New Jersey 

2.16.840.1.113883.3.520.4.73 Reporting Facility Identification Number for New Mexico  

2.16.840.1.113883.3.520.4.74 Reporting Facility Identification Number for New York 

2.16.840.1.113883.3.520.4.75 Reporting Facility Identification Number for North Carolina 

2.16.840.1.113883.3.520.4.76 Reporting Facility Identification Number for North Marianas Islands 

2.16.840.1.113883.3.520.4.77 Reporting Facility Identification Number for North Dakota 

2.16.840.1.113883.3.520.4.78 Reporting Facility Identification Number for Ohio  

2.16.840.1.113883.3.520.4.79 Reporting Facility Identification Number for Oklahoma 
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2.16.840.1.113883.3.520.4.80 Reporting Facility Identification Number for Oregon 

2.16.840.1.113883.3.520.4.81 Reporting Facility Identification Number for Pennsylvania 

2.16.840.1.113883.3.520.4.82 Reporting Facility Identification Number for Puerto Rico 

2.16.840.1.113883.3.520.4.83 Reporting Facility Identification Number for Rhode Island 

2.16.840.1.113883.3.520.4.84 Reporting Facility Identification Number for South Carolina 

2.16.840.1.113883.3.520.4.85 Reporting Facility Identification Number for South Dakota 

2.16.840.1.113883.3.520.4.86 Reporting Facility Identification Number for Tennessee 

2.16.840.1.113883.3.520.4.87 Reporting Facility Identification Number for Texas 

2.16.840.1.113883.3.520.4.88 Reporting Facility Identification Number for Utah 

2.16.840.1.113883.3.520.4.89 Reporting Facility Identification Number for Vermont 

2.16.840.1.113883.3.520.4.90 Reporting Facility Identification Number for Virginia 

2.16.840.1.113883.3.520.4.91 Reporting Facility Identification Number for Virgin Islands 

2.16.840.1.113883.3.520.4.92 Reporting Facility Identification Number for Washington 

2.16.840.1.113883.3.520.4.93 Reporting Facility Identification Number for West Virginia 

2.16.840.1.113883.3.520.4.94 Reporting Facility Identification Number for Wisconsin 

2.16.840.1.113883.3.520.4.95 Reporting Facility Identification Number for Wyoming  

 


